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  Briefly Introduce CDMD-OA and yourself.  Inform students of:

· Restroom Facilities

· Parking

· Break schedule

· Refreshments

· Any concerns?
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· Have the students introduce themselves, tell where they are from, how they will use CDMD-OA, and what they expect from the class. 
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· Review objectives.


	Introduction to the
Configuration Data Managers’ Database – 
Open Architecture System

The Instructor Guide presents CDMD-OA general concepts and the fundamentals of program use.

Course Objectives

· Understand the SCLSIS Program,  key roles and responsibilities

· Understand Strategic Data Flow and ASI processing 

· Understand CDMD-OA functions

· Build Ad Hoc queries, Browse windows and Detail Screens

· Help Files

· Query References, Create Standard Reports, use Utilities

· Build user workfiles (Copy, Insert and Delete Configuration, Alteration and Logistics Records)

· Share workfiles, Copy Queues to Summary and print VALAIDs

· Globally replace data in workfiles

· Import SDIF data into workfiles

· Labs
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	Chapter 1 – SCLSIS XE "SCLSIS" 
Chapter  Objective

Chapter 1 introduces students to:

· SCLSIS XE "SCLSIS"  functionality

· SCLSIS XE "SCLSIS"  roles and responsibilities

· Strategic Dataflow and ASI processing

· CDMD-OA software structure

Definition

The Naval Sea Systems Command (NAVSEA) developed the Ship Configuration and Logistics Support Information System (SCLSIS XE "SCLSIS" ), a configuration status accounting system, to improve configuration and logistics management and control processes for Navy ships and selected shore activities.  NAVSEA Technical Specification 9090-700 (Series) is the guiding directive.  CDMD-OA maintains the SCLSIS distributed database and its associated processes.

Background

The Department of Defense (DoD) determined the need for effective configuration management and logistics support of systems and equipment.  In response, the Navy defined policy and implementation requirements for configuration management.  Configuration management support for Navy ships and assigned activities requires large volumes of information.  Ship maintenance, alterations, and logistics support relies on control of and access to current, complete, and accurate configuration and logistics data.  NAVSEA designed SCLSIS XE "SCLSIS"  to meet these needs.

The first test of CDMD-OA was at Ingalls Shipbuilding in Pascagoula, MS.  Installation at all CDM sites soon followed.

Overview

SCLSIS XE "SCLSIS"  provides direct support to fleet maintenance and material readiness.  It addresses all configuration-worthy items necessary for the operation, maintenance, modernization, and support of shipboard and shore-based equipment.  Recent additions to the system include software, systems, services, compartments, Materials and Management System (MAMS - anything that can have a job assigned to it), and the Organization Maintenance Management System-Next Generation (OMMS-NG).  SCLSIS also provides for technical data reviews and equipment configuration audits.

The SCLSIS XE "SCLSIS"  database is the CENTRAL database.  As such, it is the central data repository for ship configuration and associated logistics support information.  The SCLSIS database subsumes the earlier Ship Configuration and Logistics Support Information (SCLSI) and Weapons System File Download (WSFD) databases.

NAVSEA assigns a Configuration Data Manager (CDM) to maintain configuration and logistics support data for each ship class represented in CDMD-OA.

Roles and Responsibilities

The Navy established requirements to implement the Department of Defense policy for effective configuration management to improve Fleet Readiness and maintain cost control.  The system includes the following roles and responsibilities:

· Naval Sea Systems Command (NAVSEA)

· Program Manager (PM) for control and maintenance of ships’ configuration data, including related platforms, systems, and equipment.

· NAVSEA 04L (Deputy Commander for Fleet Logistics Support)

· Manages and directs the development, implementation, operation, maintenance, and improvement of configuration management.

· Responsible for the development and update of NAVSEA Technical Specification 9090-700x (presently being updated to revision C).

· Ship Program Manager (SPM)

· Tasks CDM to perform SCLSIS XE "SCLSIS"  functions.

· Monitors progress of all Integrated Logistics Support actions.

· Type Commanders (TYCOM)

· Responsible for readiness support, logistics support, and administrative management.

· Guides/promotes support and utilization of SCLSIS XE "SCLSIS"  in the Fleet.

· Programs, budgets, and authorizes Type “D” and “F” alterations.

· Schedules and coordinates shipboard validations.

· Assigns ILO/ILR availability in FMPMIS.

· Configuration Data Manager (CDM)

· Manages the SCLSIS XE "SCLSIS"  database to support logistics for all ship/site systems, equipment, components, and computer programs.

· Participates in design and logistics program reviews.

· Schedules and conducts database reconciliation (DBR) using CDMD-OA and provides feedback to ship, shore activity, ISEA or any other source deemed necessary by the SPM and/or CDM managers.

· In-Service Engineering Agents (ISEA)

· Technical agent for assigned systems, components, and equipment.

· Provides planned and confirmed configuration/alteration data to the CDM.

· Provides list of impacted equipment to ship at completion of installation.

· Provides installation completion data electronically via workfile to the CDM.

· Resolves discrepancy data reported by the ship, ISEA, and other sources at the request of the CDM.

· Updates and corrects missing, inaccurate, or incomplete equipment information to the CDM via CDMD-OA.

· Navy Inventory Control Point (NAVICP)

· Maintains the Weapon Systems File (WSF).

· WSF Level A contains the configuration header data relating to a ship or shore activity, e.g., Unit Identification Code (UIC), ship type and hull number, or shore activity name, type commander, and status (active or reserve).  Trailer data in Level A identifies by Allowance Parts List (APL) the number of all equipment installed or assigned to each ship along with system and location information.

· Level C contains APL header data, e.g., nomenclature, manufacturer, tech manuals, and descriptive equipment information.  Level C trailers contain data identifying and describing all spares and repair parts XE "parts"  used at all levels of maintenance.

· WSF Level C also includes coded information concerning provisioning decisions.  It is the central computerized repository for equipment configuration and piece part information on equipment installed in Navy ships and at selected shore activities.

· Integrated Logistics Overhaul (ILO) Team/ Fleet Technical Support Center Pacific (FTSCPAC)

· Improve ship readiness by providing logistics support products that accurately reflect the ship’s configuration.

· Train Fleet personnel to use and maintain the logistics support products so they may provide a high level of support during the ship’s operational period.

· Provide additional analysis and training assistance required by Fleet units during their operational cycles.

Strategic Data Flow

The Strategic Data Flow diagram presents a simplified version of the configuration management dataflow.  It illustrates where RADFILE (Revised Alternative Dataflow File) moves data files between servers automatically.  An R indicates the RADFILE transfer system while an M denotes a manual method.  RADFILE is the same as RADCOM (Revised Alternative Dataflow Communications) without the Graphical User Interface (GUI).  The automated system uses RADFILE; end users transfer data via the RADCOM GUI.

This is a Context diagram.  The process labeled “P0” represents the boundary of the CDMD-OA system.  The arrows show the dataflow from all entities that interface with CDMD-OA.
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Automated Shore Interface (ASI XE "automated shore interface" ) Process

Starting the ASI XE "automated shore interface"  loop, a ship must submit Current Ship’s Maintenance Plan (CSMP) Upline reports twice each week via RADCOM.

Configuration change data from the data file transfers to Central, then moves to the CDM’s server XE "server"  as a workfile of item type CK.

Once the CDM processes the CK, a record transfers to the ASI XE "automated shore interface"  Store and Forward file which the ship views again via RADCOM.  The ASI Store and Forward file shows the number of records available so the ship can request an ASI Build and perform ASI on demand.

Upon the ship’s request, the system builds an ASI XE "automated shore interface"  file accessible from the ship’s RADCOM Mailbox by selecting Available Product.  The ASI loop completes when the ASI enters the SNAP database.

NAVICP Loop

CDMD-OA generates C14 XE "C14"  transactions (adds, changes, and deletes) and sends them to NAVICP to update WSF Level A.  Level A identifies all installed systems and equipment by a specific configuration (end item).  C14 transactions keep CDMD-OA and the WSF synchronized.

CDMD-OA generates E52 XE "E52"  transactions as R triggers (range adds and depth increases) to the WSF Level C for supply support computations.  Level C contains maintenance worthy repair parts XE "parts"  for Level A end items.

NAVICP also provides Repairable Identification Code (RIC) updates and Component Characteristic File (CCF XE "component characteristics file" ) updates.
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SDIF XE "standard data interchange format"  Files

CDMs and ISEAs can submit SDIF XE "standard data interchange format"  files to CDMD-OA via RADWEB.  

ISEAs, ILOs or aother activities may use RADWEB and the Send RAD Mail Option.  Select Activity CDMD Central and a RAD Type of ISEA or ILO Upline.  Ensure your file is in 419 character SDIF format and saved as a text file.  After clicking Next, select the file and allow RAD to zip the file.  This file is forwarded to Central and then automatically sent to the appropriate CDM Server in the form of a Work File, where the CDM then processes the data

NSLC Mechanicsburg Loop

NAVSEALOGCEN Mechanicsburg updates the SAC XE "service application code" /EIC XE "equipment identification code" /ESWBS XE "expanded ship work breakdown structure"  reference files XE "reference files"  manually.  They also store 3M reports in a history file.

CDMD-OA Functions

The client/server XE "server"  architecture of CDMD-OA allows queries to a single repository containing all naval configuration and logistics data.  The system provides a distributed data environment with data centralized for query XE "query"  access and localized for editing.  The replication of data between local and central servers guarantees synchronization.

· Provides configuration and logistics tracking during operational life of ship

· Provides allowance and configuration data to NAVICP WSF

· Packages supply and configuration data for transfer to ship

· Provides CDM authoring tools

· Class Functional Configuration control

· Global search and replace

· Integrated edit checking

· CK/JCN processing

· Global reference data

· Fleet-wide ESWBS XE "expanded ship work breakdown structure"  standard

· RIC/APL

· Other workfile reference data

· Module provides online change control

· Creates workfiles XE "workfiles"  for CDM review

· Provides validation aids XE "validation aids" ; hardcopy or Total Onboard Material Configuration Audit Tool (TOMCAT)

· Automated database reconciliation (DBR) with SNAP 

· Centralized index of shipboard components with links to planning and executing logistic data

· NAVICP tool for XRIC tracking

Hardware Configuration

The system hardware configuration diagram illustrates the relationships between LANs, Central servers, ship, and shore connections.  CDMD-OA supports In-Service Engineering Agents (ISEAs) with cross-hull update capability when creating work queues for CDMs.

The RADCOM servers, RADLANT and RADPAC, mirror each other.  CDMD-OA operates in an NT domain while the main data repository (Central) runs on a UNIX operating system.  Two gateway servers, RADFILE LANT and PAC, complement the CENTRAL LANT and PAC servers.

Central Lant and Central Pac are the repositories for all data.  Data replicated from all remote sites provides a complete SCLSI database for ships and shore activities.  A replication process for mirroring CENTRAL LANT and CENTRAL PAC is under development.  At this time, the Indian Head server XE "server"  (CENTRAL LANT) provides a development environment and backup repository for the Concord (CENTRAL PAC) database.

CDM Site Servers

CDM sites review and change configured data on the remote site servers.  The system replicates these databases to the Central repository.  The SMP6 label indicates a symmetric multiprocessing unit incorporating up to six CPUs.

Networks

A Local Area Network (LAN) is a group of computers and other devices dispersed over a relatively limited area and connected by a communications link that enables any device to interact with any other on the network.  LANs commonly include microcomputers and shared resources such as laser printers and large hard disks.

LSD XE "logistics support document"  Object Repository

The old Central server XE "server" , known as SAFE because it was accessed through a Data Encryption Unit (DEU) and able to store classified documents, now stores electronic documents such as Logistics Support Documents (LSD XE "logistics support document" ) as a BLOB data type. The system links LSDs to configuration records allowing users to retrieve electronic copies.

Currently, the server XE "server"  stores Y2K Certification Documents and various Baseline Automated Industrial Management (BAIM) documents such as Job Summary Reports (JSR) and Task Group Instructions.  BAIM is the system used by public shipyards to manage ship overhauls.

Server Locations

The Distributed Database and Data Warehouse graphic shows the CDMD-OA system server XE "server"  locations around the country and their relationships to each other.  CDMs have remote servers at their local sites.  Each CDM server contains the portion of the SCLSIS XE "SCLSIS"  database corresponding to the ships and activities of the responsible CDM.  Ships and activities access the Shipboard Non-Tactical ADP Program (SNAP) system that contains a replica of the necessary files from the SCLSIS database.  Transactions relay from ship to shore and shore to ship, keeping shore base and shipboard databases synchronized.

The system replicates changes made by the CDMs on remote servers to a central repository on the Central server XE "server" .  Currently, NSLC Pacific in Concord, California maintains the Central server.  In the near future, east coast users will access a Central Server located in Indian Head, Maryland.  West coast users will continue to use the NSLC Pacific Central server.  Each server will mirror the other’s data.

Distributed Database & Data Warehouse

The Central server XE "server"  retrieves and replicates changes recorded in the admin_user_chgs table of each remote server’s CDMD database.  This table records a detail XE "detail"  log of each change made in the local database.  Central processes the remote servers one at a time, continuing its activity twenty-four hours a day, seven days a week.

Typically, Central is only minutes behind the updates taking place in the field at the remote sites.  Select the Utilities|Replication menu option to view replication status XE "replication status"  on Central. 

Prior to starting replication, the CDMD team copied each remote database to Central.  Periodically, they re-synchronize Central with all of the remote servers, analyze data differences, and tune the replication program as needed.

Sites on Local NT Servers

CDMs that have an Intergraph SMP6 – NT server XE "server"  located at their site:

Ingalls Shipbuilding, MS

Newport News Shipbuilding, VA

Norfolk Naval Shipyard, VA

Puget Naval Shipyard, WA

Puget Naval Shipyard, Detachment Boston, MA

Bath Iron Works, ME

Portsmouth Naval Shipyard, NH (Non SMP6)

NISE East, Charleston, SC

NSLC FSO, Mayport, FL

AMSEC LLC

AMSEC CVN

Sites sharing a common remote Intergraph SMP6 – NT server XE "server"  located at Indian Head, MD:

NSWC, Dahlgren, VA

NISE – TSA, Charleston, SC

CSS FMS, Panama City, FL

FTSCLANT, Norfolk VA

NSLC Training, Mechanicsburg, PA

NAVICP, Mechanicsburg, PA

Litton – PRC, Reston, VA

USCG, Baltimore, MD

Client Application Overview (User Interface)

· CDMD-OA Executables

· Cdmd-oa.exe

· Cdmd-adm.exe

· Windows Application

· Graphical User Interface (GUI)

· Multiple Document Interface (MDI)

· Basic Window Conventions

· Control – X:  Cut

· Control – C:  Copy

· Control – V:  Paste

· Right Mouse click for the Cut, Copy, Paste functions

· When selecting, the following are very effective shortcuts

· Shift-Click:  Selects all records between a previously selected record in a list and the record clicked

· Control-Click:  Selects or deselects specific records

Web Site

Http://www.cdmd.navy.mil

WEB APPLICATIONS

Request a CDMD-OA Account

DOWNLOADS

CDMD-OA Installation/Updates

RADCOM Install

REFERENCES

Tech Spec 9090-700C

CDM Contact List

TRAINING

Training Schedules

Training Sites

Training Material

HELP DESK

Request Tech Support

Help Desk

Knowledge Base

Tips and Diagnostics

CDMD-OA and RADCOM HELP
Hours:

0700-1700 EDT

Telephone:
904-270-7349 (East Coast)



904-759-4065 (after hours duty phone)


925-246-5963 (West Coast)
Heatweb@nslc-jax.spear.navy.mil
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	Chapter 2 – CDMD-OA OVERVIEW 

Chapter  Objective

Chapter 2 introduces students to:

· CDMD-OA functionality

· Hardware Configuration

· Distributed Database and Warehouse

· Client Overview and Windows Conventions

· Web Site

CDMD-OA software structure CDMD-OA Overview

The Configuration Data Managers’ Database – Open Architecture system tracks the status and maintenance of naval equipment and related logistics items, such as drawings and manuals, for ships and naval activities around the world.  CDMD-OA is a client/server-based system featuring an open architecture that is independent of any vendor’s proprietary software.
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Access CDMD-OA and display Login window.  Use this instructor guide to ensure each area is covered.

Call Help Desk for log on XE "log on"  problems

(904) 270-7349; DSN 960

Students log on XE "log on"  to CDMD-OA

Expired password XE "password"  notification

Display Change Password or User Information window.


	Chapter 3 – Logging On to CDMD-OA

Chapter Objective

Chapter 3 shows students how to:

· Log on to CDMD-OA

· Change a Password

Logging on to CDMD-OA

Overview

Viewers and ISEAs connect XE "connect"  to CENTRAL.  CDMs connect to their remote site servers. CDMD-OA reads a specific .ini file corresponding to the database selected in the drop-down list on the Login window.  The CDMD-OA installation program created the .ini files in your CDMD directory.

· Cdmd-oa.ini initializes when you select LOCAL from the drop-down list.

· Central.ini initializes when you select CENTRAL from the drop-down list. 

A successful log on XE "log on"  also requires the tnsnames.ora file.  The CDMD-OA installation program created the file in the \orant\network\admin directory.  This file contains a list of Server Names with connection data.  The server XE "server"  name in your .ini file must appear in and exactly match a server name in your tnsnames.ora file.

Your complete logon ID is (your_uic) + (your_id).  An example of a complete logon ID is N32092CDMD.  You need only type your ID when you log on XE "log on"  to CDMD-OA since the .ini files provide your UIC.  Example: CDMD.  However, your account provides access to other web pages that require both your UIC and ID for access.

Procedure

To log on XE "log on"  to CDMD-OA:

1. Start the CDMD-OA program.

2. Select a database from the drop-down list.

Note:
The program defaults to LOCAL.  Navigating to the \CDMD directory and copying your central.ini file to your cdmd-oa.ini file omits this step; then LOCAL equals CENTRAL. 
3. Type your User ID.

4. Type your Password.

5. Press <ENTER>.

Expired password XE "password" :

CDMD-OA requires you to change your password XE "password"  every three months.  The Change Password or User Information for: (your user ID) window appears after you complete the logon process.

1. Fill in the following fields:

· New Password

· Verify Password

· Update your code, phone, and e-mail if necessary.

2. Click Update.

Note:
Your password XE "password"  must be alpha numeric, six characters.

To change your password XE "password" :

1. Log on to CDMD-OA.

2. Click Utilities on the menu bar.

3. Click Change Pwd or User Info.

4. Fill in the following fields:

· New Password

· Verify Password

· Code

· Phone

· E-mail.

5. Click Update.

Note:
Your password XE "password"  must be alpha numeric, six characters.




	[image: image47.wmf]
Display CDMD-OA main window

Discuss menu bar, tool bar, and status bar

You may wish to use the Graphical guide to the GUI in the Help File in the application for this.

MENU BAR
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See Chapter 8 for specifics

QUERY
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	Chapter 4 – CDMD-OA Window Environment

Chapter Objective

Chapter 4 introduces students to:

· CDMD-OA window layout

· Menu bar functions

· Tool bar functions

· Status bar functions

Main CDMD-OA Window

Purpose

The CDMD-OA main window provides access to all the program’s features.

Accessing the Main CDMD-OA Window

The CDMD-OA frame, or main window, appears after you log on XE "log on"  (See Chapter 3).  Occasionally, an Items Needing Feedback window appears within the main window.  Depending on your user role, the window includes up to three types of items:

· New Release information (See Chapter 11)

· Autosirs requiring feedback (See Chapter 11)

· X-RICs requiring feedback (See Chapter 11)

For each item, you can:

1. Select an item and click Detail, or

2. Select the check box under User Reviewed, or

3. Click Quit to exit the Items Needing Feedback window. 

Menu Bar

The menu bar provides access to CDMD-OA functions.  Click a menu name to view the corresponding drop-down menu.

Available functions vary in response to currently open windows and your user rights.
File
Save As – save data in various formats

Print – print selected data

Printer Setup – set printer options

Exit – exit CDMD-OA system

Query

Note:
This is the starting point at which you select the database file you want to query XE "query" .

Ship/Class (1) File

Displays ship level information for all ships or activities in the system

Configuration (2) File

Contains information about systems and components that are on a ship

Logistics (3) File 

Contains manuals, drawings, and other logistics materials that refer to items contained in the Configuration (2) File.

Alteration (4) File

Contains information about changes to logistic or configuration records linked to the alteration records.  All configuration and alteration data in the SCLSI database must relate to a RIC.

Job Control Number (JCN)/Notes

The originator of a transaction assigns a JCN that identifies the transaction throughout the SCLSIS XE "SCLSIS"  loop.

User Defined Fields

Contains user defined fields and information created by CDMD-OA users.

Parts

NAVICP 

Query in NAVICP Parts directly links to NAVICP Parts table which is updated weekly.

SHIP  

Query in Ship Parts queries the history of the latest ASI C1 records sent to the ship.

Logistics Support
Not completely populated, this area contains limited access to Job Summary’s, Components, TGIs, 2E Specs and etc.

Workfile Summary

Allows review of workfiles XE "workfiles"  and their work queues and changes to their queue status.

Build User Workfile

A CDM builds user workfiles XE "workfiles"  by copying records from the master database to a work queue on the local server XE "server" , while an ISEA builds user workfiles on Central.  After the copying the records, use Workfile Summary to see a summary of information and Build User Workfile to modify them.  Build User Workfile allows you to edit and sort multiple records and access all of the other features available in the Selection, Browse, and Detail windows.  You can also edit key fields, which cannot be done elsewhere in the program, and globally change multiple records using Replace Text.  

Class Functional File (CFF XE "class functional file" )

Identifies the functional/hierarchical relationship of the ship, ship system, and equipment configuration records.  The numbering method may differ in type, but the basic function of this data element is the same.  The hierarchical structure establishes the ship to system, to subsystem, to equipment, to component relationships within the ship's data.

LSD XE "logistics support document"  Description File

Descriptive data about a particular logistics support item.  It can be a manual title, additional codes to identify discrete maintenance requirements, or other types of explanatory data.

RIC Nomenclature/ CCF XE "component characteristics file"  File

File containing nomenclature for Repairable Identification Codes (RIC) and characteristics about the component.

X-RIC XE "X-RIC"  File

An XRIC is a pseudo RIC that consists of the “X” prefix, the UIC of the CDM, and a unique alpha/numeric identifier for the item. XRIC’s are assigned to items that are not support worthy that the CDM needs to track, items that are support worthy that have not yet been assigned a RIC, or items for which the CDM cannot determine the correct RIC.

References

See Chapter 9 for details.

SAC XE "service application code"  Nomenclature File

The service application code (SAC XE "service application code" ) groups equipment, components, assemblies, and other items by system or service application on board ship.

ESWBS XE "expanded ship work breakdown structure"  Nomenclature File

Use this file to determine expanded ship work breakdown structure to build hierarchical structure codes (HSC). The data in this table may not be current.  Further, the design of this portion of the program is changing.

EIC XE "equipment identification code"  Nomenclature File

Use this file to determine equipment identification codes, either by EIC or by Nomenclature.
UDF Type Reference File 

User Defined fields are defined by an administrator for each UIC on Central or the local CDM server.  Once a UDF is defined, it may then be applied to Configuration, Logistics or Alteration records in master data or workfiles and populated with appropriate data.  
SLR Template Reference File

Selected Level Reporting Template (Reserved for SNAP).  Not yet completed.

MAMS Reference File

Maintenance Assist Modules to track XMAMs .  Not yet completed. 

Fleet UIC Reference File

Use this file to determine Fleet Unit Identification Codes.

ISEA Reference File

List of ISEA Activities with address, phone number and UIC/Equipment responsible for.  Under development.

CIM Reference File

Use this file to determine configuration item manager information.

RIN/TRIN X-Reference File

Historical record of RIN/TRIN assignments.

Research Tools

To view a list of available research tools, open the Query menu and point to Research Tools.  See Chapter 9 for details.


Source of Support


Provides a Program Description, Web site, and POC information for the Program Manager, Technical Support, Help Desk, Training and duty officer.  The Integrated Call Center updates this information in concert with the ISEA for the equipment.

User Changes

The Admin User Changes table holds all changes users make to the master data.  CDMD-OA replicates this data to Central.


RIC Quantities

Allows users to search by RIC and obtain previous and current quantities on board as well as related information such as range add cd and superceded cd.

Process History

Indicates which processes have run on the data such as asio program and ASI seq numbers.  Available only on CDM servers.

Note:
This area allows you to do forensic research on records.

ASI Store and Forwards - Stores all add, change and delete records from the CDM as well as the NAVICP records generated by E-52 and C-14.  Resides only on the assigned CDM's server for a specific class.   

User Ids in this Site

Lists the user IDs on the server and allows a query by user ID or name.  Query results include the user type, phone number, and e-mail address.

Edit

Options change based on query XE "query" .  Selections include Copy to Queue and Set Default Queue.  Global replacement of data is also accomplished from this menu.

Options

Options change based on query XE "query" .  Selections include Creating SDIF Extracts, Import SDIF into a Work File, Sorting and Filtering. 

Reports

See Chapter 10 for additional information.

VALAIDS - Produces validation aids, in long or short format, for validating equipment.

SCLSIS Report - Produces a condensed report of Configuration records including Alteration and Logistics records

HSC Hull Applicability Matrix - Produces a report for an HSC RANGE on a CLASS of ships.  You must provide a Beginning HSC, an Ending HSC, and a Ship Class.

Workfile Status – Lists all CDM sites and displays Backlog/Processed record counts for all record types.

Configuration Error Report - Edit statistics grouped by CDM sites that shows number and percent of mandatory and warning errors.

Class Counts Report – Lists the number of records associated with file types 1,2,3,4 for the selected classes.

PSR Viewer -  Reports saved as .PSR files may be viewed and printed with this PSR Viewer. 

Utilities

See Chapter 11 for information.

Window

Open the Window menu and click tile, layer, or cascade to rearrange the open windows.

Help

Help Contents

Opens the CDMD-OA Help file with Contents, Index and Search Tabs.  It also has links to the Training Guide for New Users, Using CDMD-OA (Procedures)a Graphical Guide to the GUI, and the NAVSEA Technical Specification 9090-700 Series Tech Spec.

Getting Started

This launches the Training Guide for New Users.  This is the material that is taught in the 2 day CDMD-OA Viewer and WorkFile Training Course.  

Technical Specification Definitions

Opens the Tech Spec Field Definitions topic under References in the CDMD-OA Help file.

Edit Check Description

Opens the CDMD-OA Data Edit Checks topic under References in the CDMD-OA Help file.

Table Definitions

Opens the CDMD-OA Data Tables topic under the References in the CDMD-OA Help file.

These four topics below allow the downloading of specific files when selected.
Get Latest CDMD-OA Admin File

Get Latest Main Help File

Get Latest Tech Spec Help

Get Latest Training Help

User Support

Provides information about contacting technical support.

About

Displays software, user, and system information for the current CDMD-OA session.

Tool Bar

The tool bar provides shortcuts to several often-used features.  These features are also on the menu bar.  Hover the pointer over an icon to display the function of that icon.  Click an icon to activate the function. 

Note:
In order for the Email and Word icons to function, add the following lines under the [Misc] section to both the CDMD-OA.ini and central.ini files located in the \cdmd directory:  

[Misc]

msword="c:\program files\Microsoft Office\Office\Winword.exe"

email=c:\program files\Microsoft Office\Office\outlook.exe

Supply the proper drive and directory for these .exe files if not found in the above paths.

Status Bar

The status bar displays:

· Version of CDMD-OA in use.  When you upgrade CDMD-OA, the latest version number appears on the status bar

· Activity you provided when you registered for access to CDMD-OA

· Your user ID and user role, for example, JSTRIDER (Admin)

· Free memory on your computer

· Current date and time

· Other messages may appear depending on cursor location or function

When you build workfiles XE "workfiles"  and select a work queue name, that name also appears on the Status Bar.
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Display CDMD-OA Configuration Selection Criteria Window and review objectives

Explain each item in the Selection Criteria window.  

Start with the table explanation, cover the primary table and stressing there must be at least one field from it in the query.   Move across the top of the screen, explaining each item.  Then move down the buttons explaining each on the right side.  Finally describe each of the columns in the field list.

Discuss wildcards XE "wildcards"  (See Appendix A)

Reference Library and ? icons

File Import

Discuss each command button

Click Options and discuss

Instructor-go to the Practice Lab Slide 40.  

(note that the practice labs for the ad hoc, browse and detail screens has the student Remove All and reinforces basic query procedures)
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  Slide 40
	Chapter 5 – Building Queries

Chapter Objective

Chapter 5 shows students how to:

· Use the Selection Criteria window

· Create queries

· Modify queries

· Save queries

· Delete queries

· Copy another user’s queries

· Specify filters in a query XE "query" 
· Use the Ship Hull field from the Activity table to select UICs for a query XE "query"  

Creating Queries

Ad hoc queries allow you to search a database for records that contain fields defined by the query XE "query"  and matching selection criteria applied to those fields.  For example, you can create an ad hoc query that selects all records for a particular ship that have action codes of “C” (changed) and a specified range of ESWBS XE "expanded ship work breakdown structure" .  Once you define a query, you can save it for future use.

A complete query XE "query"  process uses three different windows.  The first window, the Selection Criteria window, formulates and initiates the selection criteria.  This chapter describes its use.  The second window, the Browse window, displays the results of the selection criteria query.  Chapter 6 describes use of the Browse window.  The third window, the Detail window, displays all data for a specified record.  Chapter 7 describes use of the Detail window.

Tip:
Some users refer to the Selection Criteria window as the ad hoc query XE "query"  screen or query screen.  In common use, the terms “screen” and “window” are interchangeable.

Purpose

The Selection Criteria window enables you to retrieve data from CDMD-OA for analysis, viewing, or updating.

Accessing the Selection Criteria Window

The examples in this chapter focus on the Configuration Selection Criteria window, but the methods used apply to all Selection Criteria windows.

Click Query on the menu bar.  On the Query drop-down menu, click the file or type of data to query XE "query" .  For this example, click Configuration (2) File.

Selection Criteria Window Layout
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Table List
Lists the tables available for the current Selection Criteria window.  You can join reference tables to the primary table. The (ref) indicator identifies reference tables.  The primary table appears above the dashed line and reference tables appear below the dashed line.  You must select at least one field from the primary table.

Note:
You must select at least one field from the primary table or the query will not function.  Try to filter on the primary table fields where possible.

Fields List
Select a table in the Table list to view available fields in the Fields list.  Click a field to add it to the Field List.

Tip:
Select the delete_flag_cd field, with no filter XE "filter" , to include deleted records in the query XE "query" .

Query Name Drop-Down List and Description Box
Use the drop-down list to pick a saved query XE "query" .  A description of the saved query appears in the Description box.

Retrieve as Needed Check Box
Click the Retrieve as Needed check box to retrieve records as you scroll through the results list.  The first few records from the query XE "query"  appear without waiting for the entire query to finish, allowing you to begin work sooner.

Field List
Includes the following columns:

List
Fields with selected List check boxes appear in the results list.  Fields with cleared check boxes affect the query XE "query"  results, but do not appear in the list.  Filters function normally for selected and cleared List check boxes.

Field
Shows all fields selected for the query XE "query" .  Fields with a selected List check box appear as columns in the results window.  The top-to-bottom order of the Field list indicates the left-to-right order of the columns in the query results list.

Sort

Click the cells in the Sort column to reconfigure the sort order XE "sort order"  of the results list.

Note:
Using the Sort column is strongly discouraged unless you need to create a validation aid.  The Sort column uses server XE "server"  resources for a task the local workstation can perform faster.  Validation aids are an exception since the Validation Aid Report program uses SQL created by the Selection Criteria window as the basis for sorting the Validation Aids.

Filter

Use characters and wildcards XE "wildcards"  to filter XE "filter"  the resulting data set.  There are several ways to enter filter criteria:

· Type the selection criteria in a field’s Filter box.  The results list includes only fields with data that matches the selection criteria.
Tip:
Use wildcards XE "wildcards"  to increase flexibility and control when selecting records with filters.  You can also use logical operators when filtering or searching for records.  For example, a comma between search criteria acts as an explicit OR, while a semicolon acts as an explicit AND.  Appendix A contains a complete list of wildcards and explains their use, or search the CDMD-OA Help file XE "Help file"  for “wildcards”.
· With the cursor in the field’s Filter box, click the Ref Library tool bar button.  For certain fields, a list of allowed values is displayed which can be selected.

· With the cursor in the field’s Filter box, click the ? tool bar button.  This will open the Help window containing the definition of the field and tables in which the field is located.  At the bottom of every field definition is a link to the Tech Spec for that data element.

· Apply selection criteria saved in an external text file to a field, as follows:

1. Type [FILE] in the field’s Filter box.
2. Move the mouse pointer, press <TAB>, or click on a different field to display the Column Values window.
3. In the Column Values window, click Import.
4. In the Select Import File window, select a file.
Note:
Type the file’s name using capital letters.  The file should be in *.txt format.  Use any wildcard to separate the search criteria or use a column of values.  CDMD-OA interprets each hard return in the column as a comma, which it treats as an explicit OR operator. 

5. In the Column Values window, click Quit.

· Choose ships/activities for the ship hull field from the activity table.  Click the ship hull Filter box to display the Select Hull(s) window, then select the desired UIC.  Use shift-click or control-click to select multiple hulls.  The following considerations apply:

· A check in the Del column checkbox indicates a deleted ship/activity.  Deleted ships/activities appear only if you select the Show Deleted UICs check box.

· The drop-down list in the lower-left corner displays a subset of hulls keyed to the your account setup.

· The Sort button sorts the list of ships/activities.

· The Clear button clears currently selected ships/activities.

· The All button selects all ships/activities in the list.

· The Class button displays a list of classes.  Select one or more classes, then click OK.  The Select Hull(s) window then shows only ships/activities for the selected class(es).

· The OK button closes the Select Hull(s) window and applies the selected ships/activities to the Filter box of the ship hull field.

· The Quit button closes the Select Hull(s) window without modifying the Filter box contents for the ship hull field.

· To view and modify Filter field information, right-click the Filter box.  Point to Add’l Options on the popup menu and click Expand Filter Box.  The Filter String window appears.  To save changes, click Save.  Click Quit to exit without making changes.

Width
Specifies the column width for the item on the results list.  Some users prefer to customize the column widths.

Command Buttons

Save

Displays the Save window for saving queries.  The following considerations apply:

· The Save Screen as field is a drop-down menu of all currently saved queries.  To save as a new query XE "query" , type the new name in this field.

· You can type a description of the query XE "query"  in the Description field.

· A System Default check box is available to some users.  Select this box to set the current query XE "query"  as the system default.

· To save the query XE "query" , click Save.

· To exit without saving, click Cancel.
Note:
An Admin role may save an Organizational Level query for a given UIC.  A CDA may save a Site Level is a query.  

Delete

Deletes a saved query XE "query" .
Copy

Allows copying Queries from another user within your own UIC.  Select the User, then select the query to copy.

Reset Default

Resets your default query XE "query"  to the system default.  

Remove Item

Removes selected items from the query XE "query" .

Move Item

Allows relocation of the selected field within the Field List.

Tip:
Follow the instructions in the status bar.
Caution:  If you move the cursor over the status bar, the instructions disappear.
Remove All

Removes all fields from the Field List.

Ok

Initiates the query XE "query" .

Quit

Closes the current window.

Menu Bar

Drop-down menus function as described in Chapter 4, with the following additions:

Options

The Selection Criteria window enables the Options menu, including the following commands:

· Show SQL – Displays the SQL statement generated by your query XE "query" .  This is useful for troubleshooting query problems.
· Create SDIF XE "standard data interchange format"  Extract – Generates SDIF and other extracts, based on your query XE "query" .
· Unique Records – Returns only unique records based on the non-hidden fields selected and displays no duplicates.
· Display Counts Only – Counts the number of records meeting your criteria and returns the numeric result. Choosing this option initiates the query XE "query"  immediately.
Tool Bar

Tool Bar buttons function as described in Chapter 4.
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Display Browse window by initiating a query XE "query"  from the selection criteria window.

Demonstrate changing column order with drag and drop

Demonstrate changing sort order

Demonstrate changing column width

Explain the title bar

Discuss each command button

Click each option to display drop-down menu

Allows sorting on multiple fields

Explain the match(s,s) filter, i.e. 

match(  field, 'value' ) to further filter results

Student's hands-on with Browse window
	Chapter 6 – Browse Window

Chapter Objective

Chapter 6 introduces students to the layout and function of the Selected (record type) Records (Browse) window.

Description of the Browse Window

Purpose

The Selected (record type) Records window, commonly called the Browse window, allows you to view and edit records included in your query XE "query"  results.  The Browse window provides access to the (record type) Display window, also known as the Detail window.

Accessing the Browse Window

Initiate a query XE "query"  from the Selection Criteria window (see Chapter 5) to access the Browse window.

Browse Window Layout

The Browse window includes columns and rows of information determined by the query XE "query"  parameters chosen in the Selection Criteria window.  Columns correspond to the query fields with selected List check boxes.  Rows correspond to records that meet the selection criteria.  The left-to-right column order reflects the top-to-bottom order of the Field List in the Selection Criteria window.  You can use the mouse pointer to drag a column to a new location.  Dragging a Browse window column does not change the list order on the Selection Criteria window.

Note:  
Double-click a column header sorts items based on that field.

To change column widths in the Browse window, point to a line between two columns.  When the pointer changes shape,[image: image65.bmp], you can drag the line to widen or narrow the column on the left.  Changing a column’s width in the Browse window does not change the width specified on the Selection Criteria window.

The Browse window title bar lists the total number of records (rows) in the window and the row number of the currently selected record.  If you selected the Retrieve as Needed check box on the Selection Criteria window, the total number of rows indicated by the title bar may not be the total number of records meeting the selection criteria.  The number of records indicated reflects the total currently retrieved.  As you scroll down the window, the number changes until the program retrieves all applicable records.

Command Buttons

Errs #

Indicates the number of errors detected in the highlighted record.  Click Errs - # to display the Error Detail Report window which lists the type of error, the field in error, and the reason it is in error.

Detail

Click Detail to display the Detail window (see Chapter 7) for the highlighted record.  Double-clicking a record also displays the Detail window.

Quit

Closes the Browse window.

Right-Clicking

Right-click a record to view a menu with the following options:

History ( Record History…

Displays the Record History window for the selected record.  The Record History window details all actions made to the record.

History ( Process History…

Displays a window detailing all batch processes that affected the selected record, including the ASI XE "automated shore interface" (s) on which the record appeared.  (Not available on CDMD-OA Central.)

History ( Undo History…

Displays the User Edits Listing window listing all changes you have made since the date in the “Display Date” box.  The list displayed is not limited to the current record.  It allows you to undo changes to a record or group of records.  This option is available only in the work file area for ISEA/ILO users.

Help ( Popup Help…

Displays a popup window with the field definition for the field selected.

Help ( Detail Help…

Displays the CDMD-OA Help Window for the field selected. 

Help ( Window Help… Displays the CDMD-OA Help Window with the Working with Records in the Browse Window displayed.
Note:
Your account’s user role affects the availability of some options.

Menu Bar

Drop-down menus function as described in Chapter 4, with the following additions:

Edit

Note:
Insert, Delete, Copy, Copy Hull to Hull, Replace Text and Undo History only work for CDM users (not ISEA/ILO).   Copy to Queue, Set Default Queue, and Find Text work for CDM, ISEA, and ILO roles.Your account’s user role affects the availability of some options.

The Edit menu includes the following commands:

Insert
Inserts a blank record with a new RIN into the currently displayed query XE "query" .  Available only in the work file area for ISEA/ILO users.

Delete
Deletes the selected (highlighted) records from the on-screen query XE "query" .  Available only in the work file area for ISEA/ILO users.

Copy
Copies the selected (highlighted) records to the same ship/activity (UIC).  The new record(s) will have new RINs.  Available only in the work file area for ISEA/ILO users.

Copy Hull-to-Hull
Copies the selected (highlighted) records to another ship/activity (UIC).  The new record(s) will have new RINs.  Available only in the work file area for ISEA/ILO users.

Copy to Queue
Copies the selected (highlighted) records to a user work queue in the work file area.  (See Chapter 12 for more details.)

Set Default Queue
Creates a work queue.  The selected work queue becomes the default and appears in the status bar.  If there are no queues, a prompt asks you to create one.  (See Chapter 12 for more details.)

Find Text
Allows you to search for specific text.  The Operator “matches” is the same as the “@” wildcard (see Appendix A).

Replace Text
Allows you to find and replace specific text.  Available only in the work file area for ISEA/ILO users.

Note:
Use this feature with caution; its effects can be extensive and difficult to undo.

Undo History
Displays the User Edits Listing window listing all changes you have made since the date in the “Display Date” box.  The list displayed is not limited to the current record.  It allows you to undo changes to a record or group of records.  This option is available only in the work file area for ISEA/ILO users.

COP
Currently not used.

Options
The Options menu includes the following selections:

Record Check
Runs a record check XE "record check"  against the selected (highlighted) records.  The record check validates all data in the records.  Errors in a record cause the record text to appear in color in the Browse window.  Open the Utilities menu and click Show Field Attributes to find the text color’s meaning.

Sort Order

Displays the Specify Sort Columns window, which provides sorting options for the records in the Browse window.  Works like the Sorts button on the Tool Bar.  Double-click a column heading to sort the list on that column only.
Filters

Displays the Specify Filter window, which provides filtering options for the records in a Browse window.  Works like the Filters button on the Tool Bar.

Allows you to create searches using statistical methodology.  Using Filters, you can apply search criteria using logical operators to the contents of multiple fields.  For example, you can select all records that have fields with Config_location = ‘04-49-0-M’.  This query XE "query"  returns all configuration items within the record set that are in this shipboard location.  Full use of this feature requires some knowledge of structured query language (SQL).
Create an SDIF XE "standard data interchange format"  Extract

Displays the (record type) SDIF XE "standard data interchange format"  Selection window, which allows you to create a Standard Data Interchange Format (SDIF) extract.  CDMD-OA uses SDIF to transfer configuration and logistics data to and from other applications that support the SDIF format.  File transfers use RADCOM/RADWEB and can be scheduled in advance.
Notify Errors

Toggles error notification.  Error notification displays a warning window when a change to a record results in an error.

Goto

Allows the user to go to a specific record (row) within the query XE "query" .
Tool Bar

Tool Bar buttons function as described in Chapter 4.
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Display Detail window by double-clicking a record in the Browse window.

Define and demonstrate all functions available in the Detail window.

Describe the different colored text

Demonstrate hot fields, HSC, RIC, P RIC 

Demonstrate Reference Library Icon and ? Icon

Click each option to display drop-down menus.

Describe buttons across the bottom of the screen

Currently, only the ICC desk should update these records.

Demonstrate Right-click functions

Discuss Copy to Queue

Set Default Queue

Students hands-on Detail window

Slide 4
Go to the Appendix C for labs.  Work through labs with class participation.  Discuss each lab as time permits.

Lab 1,3,4,Alt 8,Alt 9 Rename to 1,2,3,4,5

Complete Labs in Chapter 8
	Chapter 7 – Detail Window

Chapter Objective

Chapter 7 introduces students to the layout and function of the (record type) Display (Detail) window.

Description of the Detail Window

Purpose

The (record type) Display window, commonly called the Detail window, allows you to review and edit a record.

Accessing the Detail Window

Click Detail or double-click a record in the Browse window (see Chapter 6) to access the Detail window.  This chapter uses the Configuration Display window as an example Detail window.  The methods described apply to Detail windows for other record types as well.

Detail Window Layout (Defaults)

Title Bar

Indicates the type of record displayed and related information.  For a configuration Detail window, the ship/activity type, ship/activity number, ship/activity name, and UIC appear.
Black Text

Black text indicates record information.  Black text appearing in a text box is editable.  Black text not in a text box is not editable.

Gray Text

Gray text indicates reference data from one or more of the reference tables.
Blue Label Text

Identifies the field.
Other Color Label Text

Identifies the field and indicates that the field has either a mandatory or warning error.

· Mandatory errors prevent the record from leaving the system, i.e., the record is not output to WSF or SNAP systems.  You must correct mandatory errors.

· Warning errors indicate that the field does not meet system validation edits but can leave the system.

Your local CDMD-OA system administrator sets text color attributes.  Open the Utilities menu and click Show Field Attributes to identify your local color scheme.
Text Boxes (Indented Fields)

Data in text boxes is editable for certain user roles.
Hot Fields
The Hsc, Ric, and P Ric text boxes provide special functionality.  Double-click the Hsc text box to view the Reference Class Functional File (CFF XE "class functional file" ) Data window.  The Reference RIC Nomenclature Data window appears when you double-click the Ric or P Ric text box, if the field’s value exists in that table.
Ref Library

When the cursor is in a text box, click the Ref Library button [image: image68.bmp] or open the Utilities menu and click Ref Library to display a list of reference tables or a (field name) Reference File window.

There are three types of Reference File windows:

1. Choose a value and click Apply
Select a value and click Apply to change the value in the Detail window.  Click Quit to exit without changing the value in the Detail window.

2. (Field name) Reference File window with two tables of selectable values

Applies to the DOVC and VSAC fields.  Select a value from each table and click Apply to change the value in the Detail window.  Click Quit to exit without changing the value in the Detail window.

3. (Field name) Reference File window with search

Lists all allowed values for the data element and includes the following window components:

Find Text Box

Enter data element value(s) to search for; wildcards XE "wildcards"  allowed.
Search

Click to display the Word Search window.  The Word Search window allows specification of additional query XE "query"  criteria.
Word Text Box

Enter search criteria for nomenclature; wildcards XE "wildcards"  allowed.
Sub-Search on Current Listing Check Box

Select this check box to limit the search to the currently displayed records.

Note:
You must complete one search to enable this check box.
Ok

Initiates the search.
Cancel

Closes the Word Search window without initiating a search.
Apply

Updates the field in the Detail window with the currently selected value.
Detail

When available, displays a Detail window for the selected value.
Quit

Closes the (Field name) Reference File window.
SC, PSDN, PSDIN, TNC

New Construction fields.

Command Buttons

Not all buttons may be visible or enabled.

Rec Chk

Activates the system validation edit check function for all fields in the record.
Log – #
Indicates the number of logistics records associated with the current configuration record.  Clicking Log - # displays the Logistics for Config window which lists the associated logistics records.  If there is only one logistics record associated with the configuration record, the Logistics Display window (see Chapter 8) appears.

The Logistics for Config window provides access to the Detail window for listed logistics records.  Click Detail or double-click a record to display the Detail window.  Click Quit to close the current window.

Note:
The top-most button label changes in response to the logistics record type selected.  The button’s function is under development.  When complete, clicking the top-most button will display the logistics document in the lower half of the window.

Alt – #

Indicates the number of alteration records associated with the current configuration record.  Clicking Alt - # displays the Alterations Display window which lists the associated alteration records.  If there is only one alteration record associated with the configuration record, the Alteration Display window (see Chapter 8) appears.

The Alterations for Config window provides access to the Detail window for listed logistics records.  Click Detail or double-click a record to display the Detail window.  Click Quit to close the current window.

Parts – #

Indicates the number of parts XE "parts"  records associated with the current configuration record.  Associated parts records are available only from CDMD-OA Central.  Clicking Parts - # displays the Parts for Config window which lists the associated parts records.  If there is only one parts record associated with the configuration record, the Parts Display window (see Chapter 8) appears.

The Parts for Config window provides access to the Detail window for listed logistics records.  Click Detail or double-click a record to display the Detail window.  Click Quit to close the current window.

Sos – #

Indicates the number of source of support records associated with the current configuration record.  Associated source of support records are available only from CDMD-OA Central.  Clicking Sos - # displays the Source of Support window which lists the associated source of support records.

The Source of Support window provides access to the Detail window for listed logistics records.  Click Detail or double-click a record to display the Detail window.  Click Quit to close the current window.

Udf – #

Indicates the number of user defined fields associated with the current configuration record.  Clicking Udf – # displays the User Defined Fields window.

The User Defined Fields window contains two text boxes for CDM use.  Click Save to save changes.  Click Quit to close the current window without saving changes.
Jcn – #
Indicates the number of JCN records associated with the current configuration record.  Clicking Jcn – # displays the Notes/JCN window which lists the associated JCN records.  If there is only one JCN record associated with the configuration record, the Jcn/Notes window (see Chapter 8) appears.

The Notes/JCN window provides access to the Detail window for listed logistics records.  Click Detail or double-click a record to display the Detail window.  Click Delete to delete the selected record.  Click Quit to close the current window.

Errs – #
Indicates the number or errors detected on this record.  Clicking Errs – # displays the Error Detail Report window which lists the type of error, the field in error, and the reason it is in error.

Quit
Closes the Detail window.

Right-Clicking

Right-click a record to view a menu with the following options.

Add’l Options ( Nomenclatures…

Displays a “Nomenclatures” window that gives the nomenclatures for values in various fields on the Detail window.

History ( Record History…

Displays the “Record History” window for the selected record.  The Record History window details all actions made to the record.

History ( Process History…

Displays a window detailing all of the batch processes that involved the selected record and indicating on which ASI XE "automated shore interface" (s) the record appeared.  (Not available on CDMD-OA Central.)

History ( Undo History…

Displays the “User Edits Listing” window.  The window lists all changes (not just for the currently selected record) the user has made since the date in the “Display Date” box.  Allows the user to undo changes to a record or group of records associated with a user.  This option is not available to ISEA/ILO users except in the work file area.

Note:
Your user role determines which of these options are available.

Menu Bar

Drop-down menus function as described in Chapter 4, with the following additions:

Edit

Provides the following selections:

Insert
Inserts a blank record with a new RIN into the currently displayed query XE "query" .  Available only in the work file area for ISEA/ILO users.

Delete
Deletes the selected (highlighted) records from the on-screen query XE "query" .  Available only in the work file area for ISEA/ILO users.

Copy to Queue
Copies the selected (highlighted) records to a user work queue in the work file area.  (See Chapter 12 for more details.)

Set Default Queue
Creates a work queue.  The selected work queue becomes the default and appears in the status bar.  If there are no queues, a prompt asks you to create one.  (See Chapter 12 for more details.)

Undo History
Displays the User Edits Listing window listing all changes you have made since the date in the “Display Date” box.  The list displayed is not limited to the current record.  It allows you to undo changes to a record or group of records.  This option is available only in the work file area for ISEA/ILO users.

Add Child Alts
Adds a blank child alteration record to the current configuration record.  Available to ISEA roles only when in the work area.  Only CDM roles can update master configuration data directly.  No user role can update replicated data on Central.

Add Child Logs
Adds a blank child logistics record to the current configuration record.  Available to ISEA roles only when in the work area.  Only CDM roles can update master configuration data directly.  No user role can update replicated data on Central.

Add Child Jcns
Displays the New JCN/Page window, which allows you to add a child Jcn record by specifying a value for the JCN/Page.

JCN Text Box
Specify a JCN.

Page Text Box

Specify a Page.

Assign CDM Jcn Check Box

Select the check box to fill the JCN text box with the CDM’s UIC and the Page text box with “0001”.  Available to ISEA roles only when in the work area.  Only CDM roles can update master configuration data directly.  No user role can update replicated data on Central.

Ok

Adds a JCN record with the specified JCN/Page
Cancel

Closes the New JCN/Page window without adding a JCN record.

COP

Currently not used.
Tool Bar

Tool Bar buttons function as described in Chapter 4.
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Build a query XE "query"  for each record type.

Lab 6 (7) in Appendix C

Stress fields lsd type and lsd serial number 
Complete Labs 7(5), 8(11), 9(12)

Stress fields alt type and alt id

Complete Labs 10(4), 11(13)


	Chapter 8 – Record Queries

Chapter Objective

Chapter 8 helps students understand the differences between record types.  It also shows students how to select tables and fields and set filters.

Building a Record Type 1 Query

Ship/Class (1) File displays ship level information for all ships or activities in the system.

To build a query XE "query"  for an activity:

1.
Open the Query menu and click Ship/Class (1) File.

2.
At the Selection Criteria window, select the following fields from the activity (primary) table:

· class
· ship hull
· name
· uic
· CDM
· Tycom Code
· snap type
· status.

Note:
Some of these fields may appear in the field list by default.

3.
In the Filters column text boxes, type text and/or wildcards XE "wildcards"  to limit the query XE "query"  results.

Note:
Class and Hull have special selection filters that display a table for choosing a class/hull.

4.
Click Ok or press <ENTER> to initiate the query XE "query" .  The Browse window appears.

5.
Double-click the record you want to view or select the record and click Detail.  The Detail window appears.

Detail Window Command Buttons:

Counts

Record counts update daily and appear in the Record Counts box.  To check for records added or deleted during the day, click Counts.  The total updates to the current number of records.

Find RIN

(CDM use only) - Click Find RIN to update the Last RIN element.

POC

Click POC to view the point of contact and phone number for the CDM/PY, TYCOM, ILO, Ship’s Program Manager, and, if applicable, the squadron, homeport, yard, and ship.  The address of the queried activity also appears.

Note:
POC information appears only if the cognizant activity populated the record.

Menu Options

Reports

Hull Applicability Report

Produces a report for an HSC range on a class of ships.  You must provide a beginning HSC, an ending HSC, and a ship class.

Workfile Status Report

Lists all CDM sites and displays backlog/processed record counts for all record types.

Configuration Error Report

Edit statistics, grouped by CDM sites, which show number and percent of mandatory and warning errors.

Class Counts Report

Lists the number of records associated with file types 1,2,3, and 4 for the selected classes.

Building a Record Type 2 Query

Purpose

Configuration (2) File displays information about systems and components on a ship.  Current installed equipment and systems have corresponding record type 2 XE "record type 2"  configuration records.  Configuration records may link to logistics records (record type 3 XE "record type 3" ), alteration records (record type 4 XE "record type 4" ), and job control numbers (JCN)/Notes.  Linked records provide descriptive, logistic, and technical support information for a configuration item.

Configuration records in the Configuration (2) File link to ship records in the Ship/Class (1) File.

Records in the Configuration (2) File are part of the CDM’s master database.  Only CDM’s directly edit the file.  All others submit workfiles XE "workfiles"  for review by the CDM responsible for the associated UIC.

To build a query XE "query"  for a configuration:

1.
Open the Query menu and click Configuration (2) File.

2.
At the Selection Criteria window, select the following fields:

· From the Config table:

· rin (cfg)
· ric (cfg)
· hsc (cfg)
· loc (cfg)
· any additional data you want to view

· From the activity (ref) table:

· class (act)
· ship hull (act)
· any additional data you want to view

· From the ref_cff (ref) (class functional file reference) table:

· esd (cff)
· efd (cff)
· any additional data you want to view

Note:
Some of these fields may appear in the field list by default.

Note:
Efd (cff) in the ref_cff (ref) table may not be available for some nuclear ship records due to NNPI (Navy Nuclear Propulsion Info) constraints (NOFORN).
Central does not store efd/esd for NNPI (identified by an equipment discipline of “N”.  This data is available only from the CDM.  Field text reads “See CDM for information.”

Note:
To find the table in which a field appears, open the Help menu and click on the Index tab.  In the Type in the keyword to find: box, type the field name or abbreviation.  To view a field definition, click the field name in the alphabetical list and then select either the CDMD-OA Help or Tech Spec selection.  

3.
In the Filters column text boxes, type text and/or wildcards XE "wildcards"  to limit the query XE "query"  results.

Note:
Class and Hull have special selection filters that display a table for choosing a class/hull.

4.
Click Ok or press <ENTER> to initiate the query XE "query" .  The Browse window appears.

5.
Double-click the record you want to view or select the record and click Detail.

Command Buttons

Command buttons provide access to further information associated with the current record.  Command buttons with a dimmed (gray) label indicate that no related information is available.

Log – #
Displays a list of logistics items associated with the current record.

Alt – #
Displays alterations associated with the current record.

Parts – #
Displays parts XE "parts"  information associated with the RIC.

Sos
Displays source of support data.

UDF XE "user defined field"  – #
Displays user defined fields.

Jcn – #
Displays a history of all job control numbers applied to the record item number (RIN)

Errs – #
Lists and describes errors in the current record found by the SCLSIS XE "SCLSIS"  edit checks.

Quit

Closes the current window.

Building a Record Type 3 Query

Purpose

Logistics (3) File displays logistics information associated with configuration records.  Associated logistics documents include manuals, drawings, and other materials pertaining to items in the Configuration (2) File.  Logistics records are child records of configuration records.  After creating a logistics record, you can create and associate alteration records and Job Control Numbers (JCN)/Notes as child records of that logistics record.

To build a query XE "query"  for logistics records:

1.
Open the Query menu and click Logistics (3) File.

2.
At the Selection Criteria window, select the fields you want displayed.  Suggested fields include:

· From the config_log table, select parent rin (log), lsd type (log), and lsd serial number (log).

· From the activity (ref) table, select class (act) and ship hull (act).

· From the config (ref) table, select ric (ref).

Note:
Some of these fields may appear in the field list by default.

Note:
To find the table in which a field appears, open the Help menu and click on the Index tab.  In the Type in the keyword to find: box, type the field name or abbreviation.  To view a field definition, click the field name in the alphabetical list and then select either the CDMD-OA Help or Tech Spec selection.  

3.
In the Filters column text boxes, type text and/or wildcards XE "wildcards"  to limit the query XE "query"  results.

4.
Click Ok or press <ENTER> to initiate the query XE "query" .  The Browse window appears.

5.
Double-click the record you want to view or select the record and click Detail.

Logistics Display Window Layout

The Logistics Display window consists of three sections:

· Top – Displays logistics support document (LSD XE "logistics support document" ) information.  The LSD SN commonly refers to the actual document number.  The LSD description comes from the LSD Description reference file, linked by LSD type and LSD SN.

· Middle – Includes last update activity information, publication NSN, and publication order point, taken from the LSD XE "logistics support document"  description field.

· Bottom – Displays parent configuration information.

Command Buttons

Rec Chk
Activates the system validation edit check function for all fields in the record.
Config

Displays the parent configuration record.

Udf – #
Displays user defined fields.

JCN – #
Displays related JCNs.

Errs – #
Lists and describes errors in the current record found by the SCLSIS XE "SCLSIS"  edit checks.

Quit
Closes the current window.

Building a Record Type 4 Query

Purpose

Alteration (4) File displays information about alterations to configuration records.

Job Control Number (JCN)/Notes (record type 5 XE "record type 5" ) records can be linked as child records to alterations records.  The ship does not receive JCN notes added to an alteration record by a CDM.

To build a query XE "query"  for an alteration record:

1.
Open the Query menu and click Alteration (4) File.

2.
At the Selection Criteria window, select the fields you want displayed.  Suggested fields include:

· From the config_alt XE "alt"  table, select:

· parent rin (alt XE "alt" )
· alt XE "alt"  rin (alt)
· alt XE "alt"  ric (alt)
· alt XE "alt"  type (alt) (FC, OA, EC, MA, etc.)

· alt XE "alt"  id (alt) (alteration number)

· alt XE "alt"  status (alt)
· From the actifity (ref) table, select class (act) and ship hull (act).

· From the config (ref) table, select ric (cfg).

Note:
Some of these fields may appear in the field list by default.

Note:
To find the table in which a field appears, open the Help menu and click on the Index tab.  In the Type in the keyword to find: box, type the field name or abbreviation.  To view a field definition, click the field name in the alphabetical list and then select either the CDMD-OA Help or Tech Spec selection.  

3.
In the Filters column text boxes, type text and/or wildcards XE "wildcards"  to limit the query XE "query"  results.

4.
Click Ok or press <ENTER> to initiate the query XE "query" .  The Browse window appears.

5.
Double-click the record you want to view or select the record and click Detail.

Alterations Display Window Layout

The Alterations Display window consists of three sections:

· Top – Displays alteration information and two reference file fields, AINAC and LSSC, from the RIC Nomenclature field.

· Middle – Includes last update activity information, ship sequence number, and other alteration related information.

· Bottom – Displays parent configuration information.

Command Buttons

Rec Chk
Activates the system validation edit check function for all fields in the record.
Log – #
Displays a list of logistics items associated with the current record.

Parts – #
Displays parts XE "parts"  information, associated with the current record, sent to the ship from NAVICP on an ASI XE "automated shore interface" .

Config

Displays the parent configuration record.

Udf – #
Displays user defined fields.

Jcn – #
Displays related JCNs.

Errs – #
Lists and describes errors in the current record found by the SCLSIS XE "SCLSIS"  edit checks.

Quit
Closes the current window.

Building a Record Type 5 Query

Purpose

Job Control Number (JCN)/Notes provides a list of 4790/CKs against a specific ship.

To build a record type 5 XE "record type 5"  query XE "query" :
1.
Open the Query menu and click Job Control Number (JCN)/Notes.

2.
At the Selection Criteria window, select the fields you want displayed.  Suggested fields include:

· class (act) from the activity (ref) table
· ship hull (act) from the activity (ref) table

· jcn XE "job control number"  (jcn) from the config_jcn_notes table

· page (jcn XE "job control number" ) from the config_jcn_notes table

· parent rin (jcn XE "job control number" ) from the config_jcn_notes table

· status (jcn XE "job control number" ) from the config_jcn_notes table
Note:
Some of these fields may appear in the field list by default.

Note:
To find the table in which a field appears, open the Help menu and click on the Index tab.  In the Type in the keyword to find: box, type the field name or abbreviation.  To view a field definition, click the field name in the alphabetical list and then select either the CDMD-OA Help or Tech Spec selection.  

3.
In the Filters column text boxes, type text and/or wildcards XE "wildcards"  to limit the query XE "query"  results.

4.
Click Ok or press <ENTER> to initiate the query XE "query" .  The Browse window appears.

5.
Double-click the record you want to view or select the record and click Detail.

JCN/Notes Window Layout

The JCN/Notes window consists of three sections:

· Top – Displays job control information and CDM remarks.

· Middle – Displays last update activity information.

· Bottom – Displays parent items information.

Command Buttons

Parent
Retrieves the parent record.

Work Queue Remarks
Type remarks about the record in the Remarks text box.  Remarks proceed to the transaction originator as part of the ASI XE "automated shore interface"  report or as part of replication.

Quit
Closes the current window.

Menu Bar

The Edit and Options menus are not available from the record type 5 XE "record type 5"  Detail window.
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Demonstrate the use of:


SAC XE "service application code"  nomenclature file


ESWBS XE "expanded ship work breakdown structure"  nomenclature file


EIC XE "equipment identification code"  nomenclature file

Explain research tools

Complete Labs 12(2), 13(Alt 6), 14(Alt 10), 15


	Chapter 9 – Reference Table and Research Tools

Chapter Objective

Chapter 9 introduces students to the CDMD-OA reference and research tools.

Available Reference Files and Research Tools

The reference files XE "reference files"  described in this chapter include:

· SAC XE "service application code"  Nomenclature File – service application code

· ESWBS XE "expanded ship work breakdown structure"  Nomenclature File – expanded ship work breakdown structure

· EIC XE "equipment identification code"  Nomenclature File – equipment identification code

Other CDMD-OA reference files XE "reference files"  include:

· UDF XE "user defined field"  Type Reference File

· Fleet UIC Reference File

· ISEA Reference File

· CIM Reference File

· RIN/TRIN X-Reference File

CDMD-OA research tools include:

· User Changes – Allows you to query XE "query"  the user changes log (admin_user_chgs).

· RIC Quantities – Allows you to view the quantity used in generating E52 XE "E52"  maintenance to NAVICP.

· Process History – Currently not replicated to Central.

· ASI XE "automated shore interface"  Store and Forward – Currently not replicated to Central.
· User Ids in this Site

Service Application Code (SAC XE "service application code" ) Reference File

The SAC XE "service application code"  groups equipment, components, assemblies, and other items by system or service application on board ship.  The SAC is similar to the hierarchical structure code (HSC) in purpose, but does not provide a hierarchical structure.  The SAC query XE "query"  results provide information for review only and are uneditable.  You select a record’s SAC in the class functional file or in a configuration workfile (wf_config table).

Note:
SAC XE "service application code"  assignments can be subjective. The data manager should define standard SAC usage for a class to eliminate ambiguity. There are approximately 22,000 different SAC values.

To view Information in the SAC XE "service application code"  Nomenclature File:
1. Open the Query menu, point to Reference, and click SAC XE "service application code"  Nomenclature File.

2. At the Selection Criteria window, select the fields you want displayed.

Tip:
The selection methods and command buttons work just as they do for creating the various record type queries.

3. In the Filters column text boxes, type text and/or wildcards XE "wildcards"  to limit the query XE "query"  results.

4. Click OK.

Note:
Select the Retrieve as Needed check box to display data quickly for queries that retrieve a large number of records.

Expanded Ship Work Breakdown Structure (ESWBS XE "expanded ship work breakdown structure" ) Reference File

The expanded ship work breakdown structure (ESWBS XE "expanded ship work breakdown structure" ) makes up the first five characters of the hierarchical structure code (HSC). The HSC resides in the class functional file (CFF XE "class functional file" ) of CDMD-OA.  All configuration records are associated with this CFF file, providing a simple means of locating records based on a ship’s functional breakdown.

To view information in the ESWBS XE "expanded ship work breakdown structure"  Nomenclature File:

1. Open the Query menu, point to Reference, and click ESWBS XE "expanded ship work breakdown structure"  Nomenclature File.

2. At the Selection Criteria window, select the fields you want displayed.  Suggested fields include:

· HSC class from the eswbs_vw table.
· ESWBS class from the eswbs_vw table. (Use default if the specific class is not listed)
· eswbs from the eswbs_vw table.

· eswbs nom  from the eswbs_vw table.

Tip:
The selection methods and command buttons work just as they do for creating the various record type queries.

3. In the Filters column text boxes, type text and/or wildcards XE "wildcards"  to limit the query XE "query"  results.

4. Click OK.

Note:
Select the Retrieve as Needed check box to display data quickly for queries that retrieve a large number of records.

Equipment Identification Code (EIC XE "equipment identification code" ) Reference File

The equipment identification code (EIC XE "equipment identification code" ) identifies, for maintenance reporting purposes, the functional location or relative position of equipment or an assembly within a given system or sub-system hierarchy.

To view information in the EIC XE "equipment identification code"  Nomenclature File:

1. Open the Query menu, point to Reference, and click EIC XE "equipment identification code"  Nomenclature File.

2. At the Selection Criteria window, select the fields you want displayed.

Tip:
The selection methods and command buttons work just as they do for creating the various record type queries.

3. In the Filters column text boxes, type text and/or wildcards XE "wildcards"  to limit the query XE "query"  results.

4. Click OK.

Note:
Select the Retrieve as Needed check box to display data quickly for queries that retrieve a large number of records.
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Create and display Validation Aid report from configuration file.

Create and display Validation Aid report from a workfile.

Create and display a SCLSI report.

Create and display a Hull Applicability Matrix report.  A good example is:


Beginning HSC: 45167*


Ending HSC: 45167*


Class: LPD 4


	Chapter 10 – Standard Reports

Chapter Objective

Chapter 10 shows students how to create application-generated reports and online statistical reports.

Validation Aids

You can generate validation aids XE "validation aids"  from the configuration master file or from a workfile.

To create a validation aid from the configuration master file:
1.
Open the Query menu and click Configuration (2) File.

2.
At the Selection Criteria window, use the fields and filters to develop a query XE "query"  that selects data representing the equipment to validate.

Note:
Specify the sort order XE "sort order"  at the Selection Criteria window before executing the query XE "query" .  To specify the sort order, click a field in the Sort column.  To undo the sort, click the field again.

3.
Open the Reports menu and select (click) one of the three VALAID formats.

Note:
The program provides no immediate indication that the report process has begun.  After a moment, a processing status message appears in the status bar at the bottom of the main program window.

When the report is complete, the file can be saved in two formats; PSR for mailing or PRN for printing.

Validation Aids may also be created from the Browse screen.

To create a validation aid from a workfile:
1.
Open the Query menu and click Build (or Process) User WorkFile.

2.
At the Selection Criteria window, use the fields and filters to develop a query XE "query"  that selects data representing the equipment to validate.

Note:
Specify the sort order XE "sort order"  at the Selection Criteria window before executing the query XE "query" .  To specify the sort order, click a field in the Sort column.  To undo the sort, click the field again.

3.
Open the Reports menu and select (click) one of the two Workfile VALAID formats.

Note:
The program provides no immediate indication that the report process has begun.  After a moment, a processing status message appears in the status bar at the bottom of the main program window.

When the report is complete, the file can be saved in two formats; PSR for mailing or PRN for printing.

Validation Aids may also be created from the Browse screen.

Ship Configuration Logistic Support Index (SCLSI) Reports

The Ship Configuration Logistic Support Index (SCLSI) is a report of configuration records and associated logistic and alteration records.  It allows you to view a selected system at a glance.

To create a SCLSI report:
1.
Open the Query menu and click Configuration (2) File.

2.
At the Selection Criteria window, use the fields and filters to develop a query XE "query"  that selects data representing the equipment to validate.

Note:
Specify the sort order XE "sort order"  at the Selection Criteria window before executing the query XE "query" .  To specify the sort order, click a field in the Sort column.  To undo the sort, click the field again.

3.
Open the Reports menu and click SCLSI Report.

Note:
The program provides no immediate indication that the report process has begun.  After a moment, a processing status message appears in the status bar at the bottom of the main program window.

When the report is complete, the file can be saved in two formats; PSR for mailing or PRN for printing.

The SCLSIS Report may also be created from the Browse screen.

X-RIC XE "X-RIC"  Report

The X-RIC XE "X-RIC"  report is a comprehensive listing of the A, B, and C card information for an X-RIC.

To create an X-RIC XE "X-RIC"  report:
1.
Open the Query menu and click X-RIC XE "X-RIC"  File.

2.
At the Selection Criteria window, use the fields and filters to develop a query XE "query"  that selects data representing the equipment to validate.

3.
Select a record and click Detail.

4.
Open the Reports menu and click X-RIC XE "X-RIC"  Report.

AutoSIRs Report

Not available at this time.

Hull Applicability Matrix Report

Displays a range of hierarchical structure codes on a class of ships.

To create a Hull Applicability Matrix report:
1.
Open the Reports menu and click HSC Hull Applicability Matrix.

2.
Type the beginning HSC.

3.
Type the ending HSC.

4.
Use the drop-down list to select a ship class or type the ship class in the text box.

5.
Click OK.

Workfile Status Report

The Workfile Status report provides an overview of status for all CDM workfile processing.  Click Graph to view a graphical representation of the status counts.

Note:
In the graph window, click to view pie charts or right-click to view counts.

Default Backlog Color Codes

· Red – backlog exceeds 10% of total.

· Yellow – backlog falls within 5 - 10% of total.

· Black – backlog less than 5% of total.

Class Counts Reports

A Class Counts report lists the number of records associated with file types 1, 2, 3, and 4 for the selected class.

To create a Class Count report:
1.
Open the Reports menu and click Class Counts Report.

2.
Use the drop-down list to select a ship class.


OR


Select User Defined, type the ship class in the text box, and press <ENTER>.

User Defined Report

Not available at this time.

PSR Report Viewer

Displays PSR format reports generated in the Reports section of CDMD-OA.  Once created these PSR reports can be mailed to another user who may view them with PSR Report Viewer.   

To use the PSR report viewer:
1.
Open the Reports menu and click PSR Report Viewer.

2.
In the Select Saved Report File dialog box, select a PSR file and click OK.

The report appears in the PSR File Viewer window with the following options:

· Select PSR Report…

· Print

· Previous Page

· Next Page

· Close
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Explain and demonstrate AutoSIRs.

Review release notes XE "release notes" and the importance to read them.

Create a query XE "query"  to demonstrate functions of the reference library.

Demonstrate if applicable.

Explain purpose of ASI XE "automated shore interface"  process.

Process SDIF XE "standard data interchange format" 
Using SDIF XE "standard data interchange format"  to transfer data.

Demonstrate process load results XE "load results" .

Demonstrate pending mail list XE "pending mail list" ings.

Demonstrate replication status XE "replication status" .

Same as right-clicking a record.


	Chapter 11 – Utilities 

Chapter Objective

Chapter 11 introduces students to:

· The Connect command

· The reference libraries

· The ASI XE "automated shore interface"  sequence

· E52 XE "E52" /C14 XE "C14"  initializations

· Replication status

Additionally, this chapter shows students how to:

· Create and/or review AutoSIRs

· Review release notes XE "release notes" 
· Review change request XE "change request" s

· Change passwords or user information

· Review field attributes

· Review SDIF XE "standard data interchange format"  extract production statistics

· Check pending mail

· Review process loads results

Connect Command

Use the Connect command, found on the Utilities menu, to disconnect the current session and log on XE "log on"  to another site without closing the application.

Note:
Do not select this option during class.

Submit and View AutoSIRs, Change Requests, and Release Notes

Automated System Improvement Requests (AutoSIRs)

Use AutoSIRs to submit bug reports and enhancement requests.  The Configuration Control Board (CCB) links approved enhancement requests to a change request XE "change request"  (CR).

To connect XE "connect"  to the CDMD-OA CCB Web page, open the Utilities menu and click AutoSirs.

Reporting Bugs and Requesting Enhancements

To submit a bug report or request an enhancement using AutoSIRs from the CCB Web page, click New.  A new window titled Add a New Autosir opens.  Type the Subject and a statement of the problem or requested enhancement.  Provide and example, if possible, to assist problem research.

To review the status of an AutoSIR on the CCB Web page, click the blue button [image: image75.png](%]



 found to the left of the ID number.

To return to CDMD-OA, close your Web browser.

Change Requests

NSLC Pacific may escalate system enhancement AutoSIRs, as opposed to bug fixes, to change request XE "change request" s (CR).

1.
To view CRs, open the Utilities menu and click Change Request.

2.
After the CCB Web page opens, click Change Requests from the Browse: drop-down list.

Release Notes

Release notes describe the enhancements and bug fixes incorporated in new program versions.  It is important to carefully read these upon upgrading to a new release to become aware of the bug fixes and enhancements that are included in the release.

1.
To view version release notes XE "release notes" , open the Utilities menu and click Release Notes.

2.
After the CCB Web page opens, click Releases from the Browse: drop-down list.

Password

To change your password XE "password" :
1.
Open the Utilities menu and click Change Pwd or User Info.

2.
Type a new password XE "password"  in the New Password text box.

3.
Type the new password XE "password"  again in the Verify Password text box.

4.
Complete any other required information.

5.
Click Update.

Show Field Attributes

The Show Field Attributes command displays the text field colors set by the site administrator.

To view the field attributes, open the Utilities menu and click Show Field Attributes.

Reference Library

The Ref Library command provides access to CDMD-OA reference tables.

Class Functional File (CFF XE "class functional file" )
The CFF XE "class functional file"  is a value used by CDMD-OA to identify the specific function of a piece of equipment.  It establishes a model or baseline for a class of ships.  The CFF table derives from the expanded ship work breakdown structure (ESWBS XE "expanded ship work breakdown structure" ) for Navy ships.

1.
Open the Utilities menu and click Ref Library.

2.
Click Class Functional File (CFF XE "class functional file" ) in the list.

3.
To locate information by hierarchical structure code (HSC), use the Find text box.  To locate information by equipment functional description (EFD), click Search…
Component Characteristics File (CCF XE "component characteristics file" )
The CCF XE "component characteristics file"  table provides technical characteristics for a specified repairable identification code (RIC).

1.
Open the Utilities menu and click Ref Library.

2.
Click Component Characteristics (CCF XE "component characteristics file" ) in the list.

3.
To locate information by RIC, use the Find text box.  To locate information by component text, click Search…
Equipment Identification Code (EIC XE "equipment identification code" )
The EIC XE "equipment identification code"  identifies the functional location or relative position of equipment, or an equipment assembly performing a distinct function, within the hierarchy of a system or sub-system.  Maintenance reports and 3M analysis use the EIC.

1.
Open the Utilities menu and click Ref Library.

2.
Click EIC XE "equipment identification code"  Nomenclature in the list.

3.
To locate information by RIC, use the Find text box.  To locate information by nomenclature, click Search…
Expanded Ship Work Breakdown Structure (ESWBS XE "expanded ship work breakdown structure" ) Nomenclature
The ESWBS XE "expanded ship work breakdown structure"  is the first five digits of the HSC.  The ESWBS shows the equipment boundary for ship systems.

1.
Open the Utilities menu and click Ref Library.

2.
Click ESWBS XE "expanded ship work breakdown structure"  Nomenclature in the list.

3.
To locate information by ESWBS XE "expanded ship work breakdown structure" , use the Find text box.  To locate information by nomenclature, click Search…
Expanded Ship Work Breakdown Structure (ESWBS XE "expanded ship work breakdown structure" ) Tree Structure
The ESWBS XE "expanded ship work breakdown structure"  tree structure provides a graphical view of the ESWBS for a selected ship.

1.
Open the Utilities menu and click Ref Library.

2.
Click ESWBS XE "expanded ship work breakdown structure"  Tree Structure in the list.

3.
Select a class from the Select a Class drop-down box, then select a ship from the Select a Ship drop-down box.

Fleet Unit Identification Codes (UIC)
The Fleet UICs table contains additional information associated with a UIC.
1.
Open the Utilities menu and click Ref Library.

2.
Click Fleet UICs in the list.

3.
To locate information by UIC, use the Find text box.  To locate information by activity name, click Search…
In-Service Engineering Agent (ISEA) Reference
The ISEA reference table contains additional information about ISEAs.

1.
Open the Utilities menu and click Ref Library.

2.
Click ISEA Reference in the list.

3.
To locate information by UIC, use the Find text box.  To locate information by activity name, click Search…
ISEA Cross Reference
The ISEA cross-reference table connects ISEAs and equipment.

1.
Open the Utilities menu and click Ref Library.

2.
Click ISEA Xref in the list.

3.
To locate information by UIC, use the Find text box.  To locate information by activity name, click Search…
Logistics Support Document (LSD XE "logistics support document" ) Description File
The LSD XE "logistics support document"  description file cross-references LSD serial numbers and descriptions.

1.
Open the Utilities menu and click Ref Library.

2.
Click LSD XE "logistics support document"  Description File in the list.

3.
To locate information by serial number, use the Find text box.  To locate information by description, click Search…
Repairable Identification Code (RIC) Nomenclature
The RIC nomenclature table contains information regarding RICs and their nomenclature.

1.
Open the Utilities menu and click Ref Library.

2.
Click RIC Nomenclature in the list.

3.
To locate information by RIC, use the Find text box.  To locate information by nomenclature, click Search…
Service Application Code (SAC XE "service application code" ) Nomenclature
The SAC XE "service application code"  nomenclature table contains information regarding SACs and their nomenclature.

1.
Open the Utilities menu and click Ref Library.

2.
Click SAC XE "service application code"  Nomenclature in the list.

3.
To locate information by SAC XE "service application code" , use the Find text box.  To locate information by nomenclature, click Search…
Sub Category Code (SCAT) Nomenclature
The SCAT nomenclature table contains information regarding SCATs and their nomenclature.

1.
Open the Utilities menu and click Ref Library.

2.
Click SCAT Nomenclature in the list.

3.
To locate information by SCAT, use the Find text box.  To locate information by nomenclature, click Search…
X-RIC XE "X-RIC"  Reference
The X-RIC XE "X-RIC"  reference table contains information regarding X-RICs and their nomenclature.

1.
Open the Utilities menu and click Ref Library.

2.
Click X-RIC XE "X-RIC"  Reference in the list.

3.
To locate information by X-RIC XE "X-RIC" , use the Find text box.  To locate information by nomenclature, click Search…
ASI XE "automated shore interface"  Sequences

CDMD-OA creates Automated Ship Interface (ASI XE "automated shore interface" ) transactions as part of the CDMD process as well as from NAVICP transactions received as part of the E-52 process.  These transactions update the supply and configuration information on the ship’s SNAP computer.  In some cases, CDMD-OA creates temporary transactions for use until NACICP receives the information.  The ASI process includes seven record types sent to the ship.  Each corresponds to a page (or screen) of data displayed by the ship’s SNAP system.

In the following list of ASI XE "automated shore interface"  transaction record types sent to ships:

· Transactions created by CDMD-OA (A1, A2, H1) are blue.

· Those that may use temporary record types created by CDMD-OA (B1-B7, C1) are red.

· All other transaction types, sent after NAVICP receives them, are black.
Record (Card) Types

A1, A2
– Equipment configuration data.

B1-B7
– RIC (APL/AEL) header data.

C1
– RIC (APL/AEL) to NIIN cross-reference (parts XE "parts"  list data).
D1-D7
– RIC (APL/AEL) supercede (replacement of data).
E1
– stock record file; allowances.

F1
– NIIN to part number cross-reference.

G1, G2
– NIIN supercede and management data changes.

H1
– Logistics support data (tech manuals and other support documents).

When and why CDMD-OA sends temporary B-series record types to a ship.
NAVICP takes approximately 20 days to process E-52 triggers, therefore CDMD-OA normally sends A1, A2, H1 transactions before receiving the corresponding transactions from NAVICP.  In this situation, CDMD-OA creates temporary B-series transactions, from available information in its reference tables, thereby allowing the ship to receive other transactions.

The B series transactions created by CDMD-OA may not be as current as those from NAVICP.  The NAVICP transactions, when received, replace the earlier, temporary transactions via the ship’s next group of ASI XE "automated shore interface"  transactions.

When and why CDMD-OA sends temporary C record types to a ship.

CDMD-OA sends a pseudo-C1 transaction to prevent SNAP from sending LSRI requests when there is a transaction for a RIC quantity increase (Range Add) and NAVICP has not sent the C1.  When NAVICP sends the C1, it replaces the pseudo-C1.  The following values identify pseudo-C1 transactions:

· NIIN = FAKE NIIN

· Prime Part Number = SUPPLY SUPPORT COMING

· Item Number = DO NOT ORDER

E52 XE "E52" /C14 XE "C14"  INITS

CDMD-OA generates E-52 triggers as part of routine maintenance and at the request of NAVICP during the process of E-52/C14 XE "C14"  initialization.  NAVICP uses E-52 triggers from CDMD-OA to identify changes to RICs, calculate allowance support information for a ship, and update the WSF.  E-52 transactions are essential to generating ASI XE "automated shore interface"  transactions used to update the SNAP system on the ship.

CDMD-OA creates an E-52 trigger type R1 for E-52 initializations at the request of NAVICP to initialize the SNAP database in response to:

· SNAP conversion inst

· New construction inst

· ILO init

· MAMS refresh

· Remove process

CDMD-OA creates C14 XE "C14"  initializations to update the WSF by initializing the WSF’s level A.  NAVICP can request C14 initializations on any schedule, but not for records containing an X-RIC XE "X-RIC" .

NAVICP can supersede an X-RIC XE "X-RIC"  with a valid RIC using CDMD-OA.  When a valid RIC supercedes an X-RIC, CDMD-OA creates a pseudo-C14 RIC update transaction.  The pseudo C14 XE "C14"  transaction merges with incoming C14 update transactions.

Note:
You must have a “NAVICP” user role to request an E-52 or C14 XE "C14"  initialization.

E-52 Maintenance Triggers

E-52 maintenance triggers created for configuration or alteration items that use a specific RIC must:

· Be for records with a valid RIC

· Be on SNAP ships (regardless of AUTO-MCMAR status)

· Be on non-SNAP ships that are under Auto-MCMAR

· Pass minimum edit checks

· Have a DISI field with a value of “B”

CDMD-OA creates E-52 maintenance R triggers for records based on the contents of the ric_quantity table.  CDMD-OA sends E-52 maintenance records each weekend for records that meet one of the following criteria:

R2

When the SUPERCEDED_CD field has a value of “T.”

R4

When the PREVIOUS_QTY field’s value equals zero and the CURRENT_QTY field’s value is greater than zero.

When the LSRI field’s value is “Y” and the PREVIOUS_QTY field’s value is equal to or less than (=<) the value of the CURRENT_QTY field.

R5

When the LSRI field’s value is “Y” and neither an R4 nor R6 trigger is created

R6

When the LSRI field’s value is not “Y” and the value of the PREVIOUS_QTY field’s value is equal to or less than (=<) the value of the CURRENT_QTY field.

Following E-52 trigger creation, CDMD-OA copies the CURRENT_QTY field value to the PREVIOUS_QTY field and deletes the LSRI field’s value.

Note:
An alteration record’s QUANTITY field should have a value of one.  An X-RIC XE "X-RIC" ’s CURRENT_QTY value should be zero and the true quantity for the X-RIC is the ASI XE "automated shore interface"  quantity.  If a record’s ASI_QUANTITY value equals zero, the E-52 deletes the record from the ric_quantity table.

R9 Trigger

For CDMD-OA maintenance and initialization processes, a new R9 trigger corrects COSAL and allowance problems currently associated with use of the data interface suppression indicator (DISI).  Planned adds sent with a DISI of ‘A’ do not include sufficient information for the ship to order parts XE "parts" .  Planned adds with a DISI of ‘B’ have caused requisitions needlessly to be dropped when planned installs subsequently are cancelled.  In response to the R9 trigger, NAVICP generates ASI XE "automated shore interface"  ‘B’ and ‘C’ cards, but no ‘E’ cards.  Thus, NIINs that support planned adds are visible and requisitions are not dropped.

To request a C14 XE "C14"  initialization:

1.
Open the Utilities menu, point to E52 XE "E52" /C14 XE "C14"  Inits, and click E52/C14 Inits Requests.

2.
From the Ship Type drop-down list, click a ship type or init type to filter XE "filter"  the list.

3.
In the appropriate ship’s row, select the C-14 Init Request box.

Note:
You must have a NAVICP role to use this feature.

To request an E-52 initialization:

1.
Open the Utilities menu, point to E52 XE "E52" /C14 XE "C14"  Inits, and click E52/C14 Inits Requests.

2.
From the Ship Type drop-down list, click a ship type or init type to filter XE "filter"  the list.

3.
Double-click a ship’s record.

4.
From the E-52 Initialization Request drop-down list, select one of the following:

· SNAP Conversion Inst 

· New Construction Inst 

· ILO Init 

· MAMS Refresh 

· Remove Process 

· Cancel Request 
5.
Click Quit.

Note:
You must have a NAVICP role to use this feature.

To view or cancel a pending E-52 initialization:
1.
Open the Utilities menu, point to E52 XE "E52" /C14 XE "C14"  Inits, and click E52 Inits Pending.

2.
Select Cancel for a pending initialization.

3.
Click Quit.

Note:
Using E-52 Inits Pending, you can view a list of pending E-52 initializations that includes information on the type and quantity of E-52 triggers associated with the initialization for each ship.

E-52 SNAP Trigger Types

CDMD-OA sends E-52 triggers to NAVICP.  When NAVICP returns data, CDMD-OA sends ASI XE "automated shore interface"  files to SNAP with information from both NAVICP and CDMD-OA.  CDMD-OA creates record types A1, A2, and H1.  NAVICP creates all other record types.  The following list describes E-52 triggers.

R1
Ship initialization

R2
RIC supersession

R3
New/revised APL

R4
Configuration range add

R5
Allowance request

R6
Configuration depth increase

R7
Pen and ink change

Note:
The Allowance Fund Code for all E-52 triggers is set to N (NAVSEA funded).

Following is a list of E-52 triggers and the ASI XE "automated shore interface"  record types they produce.


Trigger Type

R1
R2
R3
R4
R5
R6
R7



A1, A2


 X
 X

 X
 X
 X




B1-B7


 X

 X
 X
 X

 X



C1


 X
 X
 X
 X
 X

 X



D1-D7



 X








E1


 X
 X
 X
 X
 X
 X
 X



F1


 X
 X
 X
 X
 X

 X



G1


 X
 X
 X
 X
 X
 X




H1


 X








ASI XE "automated shore interface"  record types sent to the SNAP system update the following:

A1, A2
Equipment configuration data

B1-B7
RIC (APL/AEL) header data 

C1

RIC (APL/AEL) to NIIN cross reference (parts XE "parts"  list data)

D1-D7

RIC (APL/AEL) supersession (replacement of data)

E1

Stock record file – allowances

F1

NIIN to part number cross reference 

G1, G2

NIIN supersession and management data changes

H1

Logistics support data (tech manuals and other support documents)

Minimum Edit Checks for E-52 Transactions

When any of the following fields have a mandatory error, the associated record will not be included in an E-52 transaction:

· ALT_RIC 

· ALT_TYPE 

· ALT_ID 

· ALT_STATUS 

Note:
Fields with mandatory errors have red text in the Detail window.  Records with errors have red text in the Browse window.

Process Standard Data Interchange Format (SDIF XE "standard data interchange format" )

Transferring Data with SDIF XE "standard data interchange format"  Extracts

CDMD-OA and other applications that support the SDIF XE "standard data interchange format"  format use SDIF to exchange configuration and logistics data.  Files transfer via RADCOM.  You can schedule transfers in advance.

To view a list of processed SDIF XE "standard data interchange format"  extracts:
Open the Utilities menu and click Process SDIF XE "standard data interchange format" , then make a selection from the Extract Type drop-down list.

Note:
The check boxes in the RT3, RT4, and RT5 columns indicate whether the extract includes Alterations (RT3), Logistics (RT4), or Job Control Number JCN/Notes (RT5).

To export selected records using an SDIF XE "standard data interchange format"  extract:
1.
Open the Query menu and click Configuration (2) File.

2.
Create a query XE "query"  and click OK.

3.
From the Browse window, select a record for the SDIF XE "standard data interchange format"  extract.

4.
Open the Options menu and click Create SDIF XE "standard data interchange format"  Extract.

5.
Type a 1 to 8-character name in the Filename text box.

6.
Select the check boxes for the options you want.

7.
To schedule the SDIF XE "standard data interchange format"  extract, do the following:

· Select Scheduled.

· From the SDIF XE "standard data interchange format"  Extract Scheduling Screen window, select the month and day to schedule the extract and the interval.

· Click Save.

8.
Type a short description to identify the SDIF XE "standard data interchange format"  in the Remarks text box.

9.
Type the UIC and Code to receive the SDIF XE "standard data interchange format"  extract in the appropriate Send to RadMB group text boxes

Note:
To view a history of extracts sent, click View from the SDIF XE "standard data interchange format"  Selection window.  From other windows, open the Utilities menu and click Process SDIF.

To cancel a scheduled SDIF XE "standard data interchange format"  Extract:
1.
Open the Utilities menu and click Process SDIF XE "standard data interchange format" .

2.
From the Extract Type drop-down list, select Unprocessed.

3.
Select a record.

4.
Click Cancel Extract.

5.
Click OK.

6.
Click Quit.

Process Load Results

To determine if files from other locations are being received:
1.
Open the Utilities menu and click Process Load Results.

2.
In the Display Date spin box, enter the last date associated with records you want displayed.

3.
Click Accept Date.

Listed files have been loaded.  The number of files listed changes as files arrive.  If the number of files remains the same, an error is preventing files from arriving.

Pending Mail Listing

To determine if files are being sent to other locations:
1.
Open the Utilities menu and click Pending Mail Listing.

2.
In the Display Date spin box, enter the last date associated with records you want displayed.

3.
Click Accept Date.

The Complete Date indicates the file’s transfer date.  A blank Complete Date indicates an unsent file.

Replication Status

To view replication status XE "replication status" :
· Open the Utilities menu, click Replication Status, and click Refresh.

The selected RS check box indicates the CDM currently replicating.  A dimmed RS check box means that replication is off for that CDM.  The Replicated Through field indicates the time of replication for the last record.  Last Time Replicated indicates the last time replication ran on the site.

Record History/Process History

Shows the history of a record.  The Record History and Process History menu options appear under the Utilities menu only after you run a query XE "query"  and the Detail window opens.

Filer, Email, MS-Word, Notepad

These options appear under the Utilities menu and as buttons on the tool bar.

Filer
[image: image76.bmp]
Opens Windows Explorer.

E-Mail
[image: image77.bmp]
Opens the default e-mail program specified in your Cdmd-oa.ini file, if any.

MS Word
[image: image78.bmp]
Opens a new MS Word document, if specified in your Cdmd-oa.ini file.

Notepad
[image: image79.bmp]
Opens Windows Notepad.
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Review material from Day One.

· Answer any questions in reference to Day One

· Review building queries using LAB 1 and Appendix D

· Review three-step query XE "query"  process

· Selection Criteria window

· Browse window

· Detail window

· Review reference files XE "reference files"  – Lesson 9

· Review Help menu – Lesson 15

· Review wildcards XE "wildcards"  – Appendix A

· Review technical support


	Review
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©Lab 1, Appendix D

Review 3-Step Query Process

© Selection Criteria Screen
©Browse Screen
© Detail Screen

Review Reference Files (Lesson 9)
Review Help Menu (Lesson 14)
Review Wildcards (Appendix A)
Review Technical Support
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Easier to copy existing records than to create data on a blank screen.
Build a Workfile Query.

Note:
Instructions refer to a Configuration (2) File but the same procedure applies to Logistics (3) Files and Alteration (4) Files.

Explain how the Workfile Summary title becomes the DEFAULT summary title until the user actually RESETS DEFAULT QUEUE.

Point out summary title on status bar.

Point out where, on the status bar, you can see the ship and quantity of records being copied.

Explain the status of summaries and viewing summaries.

Do not SUBMIT records in class.

Explain Users button.

Demonstrate Copy Queue to Summary

Include summary title, action code, and other fields that you want to demonstrate changes in the query XE "query" .

An example is to query XE "query"  a ship that has planned installations in the database  (ISC = P) and change status to Installed (ISC = G).

Have a Logistics example ready to demonstrate.

Have an Alteration example ready to demonstrate.

Have an SDIF XE "standard data interchange format"  file example to use in class.
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	Chapter 12 – Building User Workfiles

Chapter Objective

Chapter 11 shows students how to:

· Create workfiles XE "workfiles" 
· View and change workfiles XE "workfiles" 
· Copy records to a workfile queue

· Add user workfiles XE "workfiles"  in WorkFile Summary
· Insert a new record into a workfile

· Delete a record from a workfile

· Globally replace data in a workfile

· Add a new logistics record to a workfile record

· Add a new alteration record to a workfile record

· Import SDIF XE "standard data interchange format"  into a workfile

· Change the default workfile

· Submit SDIF XE "standard data interchange format"  to CDMs via RADCOM

Workfiles

CDMs can create workfiles XE "workfiles"  on a local server XE "server" .  ISEAs create workfiles on Central.  Both select records from the master database and copy them to work queues within the workfile.  They select records by running a query XE "query"  from the Selection Criteria window and then choosing from the results in the Browse window.

When you first select a workfile during a CDMD-OA session, it becomes the default workfile for copying records.  You can change the default workfile.  A workfile can include multiple work queues, each associated with a different UIC.

Once a workfile contains copied records, you can view it by clicking WorkFile Summary on the Query menu.

To create a workfile:

1.
Open the Query menu and click Configuration (2) File.

2.
At the Selection Criteria window, select the fields you want displayed.

3.
In the Browse window, select the records to copy.

4.
Open the Edit menu and click Copy to Queue.

Note:
The Copy to Queue command copies records to a workfile.

5.
From the WF Summary Selection window, select the workfile to which you want to copy the records and click OK.


OR


From the WF Summary Selection window, click Add New to add a new workfile and type a descriptive title in the Enter Summary Title text box.

Note:
The text typed in the Enter Summary Title text box becomes the workfile’s title.  Use a short descriptive title that clearly identifies the workfile; such as “Ship name, date.”  After you copy records to a workfile, that workfile becomes the default.

6.
In the Copy Selection Criteria dialog box, select Copy to same UIC if you want to copy records to the same ship (CDMD-OA assigns existing RINs) or Copy to One or Multiple UICs (CDMD-OA assigns TRINs).  Select the information to copy, i.e., Logistics (RT 3), Alterations (RT 4), and/or User Defined Fields (UDFs) and click OK.

7.
If you selected Copy to One or Multiple UICs, the Select Hull(s) window appears allowing you to select the appropriate hulls.  After selecting hulls, click OK.

Workfile Summary

The Workfile Summary Listing window allows you to review workfiles XE "workfiles" .  Click Detail to view the work queues in a workfile.  After building and modifying a workfile, click Submit to send it to the responsible CDM(s).  After submission, a workfile’s status changes from Build to Sent to CDM.

The Workfile Summary Listing window displays Open summaries by default.  After submission, a workfile no longer appears on the Open list.  To view a list of submitted workfiles XE "workfiles" , select Sent to CDM from the unlabeled drop-down list in the lower left-hand corner of the window.
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To assign viewing and editing rights for a workfile to other CDMD-OA users:

1.
In the Workfile Summary Listing window, click Users.

2.
In the Allowed Users for (workfile) window, click Insert.

3.
In the Select Users window, select the users to share viewing and editing rights and click OK.

4.
If the list of users is complete, click Quit to close the Allowed Users for (workfile) window.

Note:
If multiple users modify workfiles XE "workfiles" , the most recent user’s changes overwrite those made by other users.

To view a list of work queues in a workfile:
1.
Open the Query menu and click WorkFile Summary.

2.
Select the workfile you want to view and click Detail.
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The Work Queue window displays the work queues from the selected workfile.  Each work queue corresponds to a separate UIC.  The display includes the number of records in and status of each work queue.  CDMs use the Uc check box to update the Class Functional File (CFF XE "class functional file" ) with the data from your workfile.  When the CDM selects the Uc check box, CDMD-OA automatically adds/replaces a CFF record.  Select a work queue and click Detail to view its records.

Copy Queue to Summary:

1.
Open the Query menu and click WorkFile Summary.

2.
Select the workfile you want to view and click Detail.
3.  Select a work queue from the Work Queue window list.

4.  Open the Edit menu and Click Copy Queue to Summary.

5.  Close the WorkFile Summary Window, then reopen it to see the new Workfile. 
To view a list of records in a work queue:
· Select a work queue from the Work Queue window list and click Detail.
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The drop-down lists at the top of the Manual Review Configuration Records window filter XE "filter"  the records list in various ways:

Rec
· View All records

· RT2 only

· RT3 only

· RT4 only

Hsc

· View All records

· Records with Blank HSCs

· Records with CFF XE "class functional file"  changes (CFF Chgs)

· Records with unknown HUIs (Unkn HUI)

Action
Filters the record list by selected action code.

Display
Defaults to Manual Review for non-CDM users.  Other options include:

· Ready for AutoProc

· Processed

· Deleted Records

· Unprocessed

· Deferred

The Display setting affects the information boxes at the lower left of the window as well as the contents of the records list.

To view a record from a work queue:
· Select a record from the Manual Review Configuration Records window list and click Detail.
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The Building WorkFile Config Display window displays the color-coded errors that need correction before submitting the record to the CDM for processing.  You can edit fields in this window, but you should use the Build User Workfile area for that purpose.

Building a User Workfile

Using the BUILD User WorkFile command, you can add, delete, sort, and modify records using the features available in the Selection Criteria, Browse, and Detail windows.  You can edit key fields, which can not be done elsewhere in the program, and globally change multiple records.  Additionally, you can print reports and save records in a variety of formats for use in programs such as Excel or Dbase.

To edit or modify records in a workfile queue:
1.
Open the Query menu and click Build User WorkFile.

2.
In the Selection Criteria for BUILD Work File Cfg window, use the Summary Title field as search criteria by typing the summary title of the workfile you want to edit.

Note:
The Summary Title filter XE "filter"  field is case sensitive.  Type it exactly as assigned.

3.
Select ship hull(s).

4.
Be sure to include actions (wf_cfg), and other fields you plan to edit, in your query XE "query" , then click OK.

When CDMD-OA completes the query XE "query" , fields are editable in both the Browse and Detail windows.

White Text

White text appearing in workfile records comes from the original record used to create a workfile on Central.  It will not appear in the submitted workfile.  To submit all or a portion of the white text information, use the following procedures.

To include white text for a field:
1.
Select the field you want included in submissions.

2.
Right-click the field to access the shortcut menu.

3.
Point to Add’l Options and click Copy Field Master Data.

The white text becomes black, indicating that it now is part of the workfile record.

To include all white text in a record:
1.
Right-click anywhere on the record, except in a field, to access the shortcut menu.

2.
Point to Add’l Options and click Copy All Master Data.

The white text becomes black, indicating that it now is part of the workfile record.

Global Replacement of Fields

When multiple records require identical edits, you can build a query XE "query"  that includes those fields and globally replace data.

1.
Create a query XE "query"  to retrieve the records you want to edit.  Be sure to include the appropriate fields for display.

2.
Open the Edit menu and click Replace Text.

3.
In the Data Replace dialog box, select a field name from the Field to Search drop-down list.

4.
Type the text you want to find, or use wildcards XE "wildcards" , in the Search For text box.

5.
In the Change To text box, type the new text.

6.
Click Change All to replace all instances that match the Search For text.


OR

Click Search and Verify to confirm each replacement.

Note:
You can modify only key fields contained in the primary database while using Build WorkFile.

Tip:
Wildcards significantly increase your options when replacing data in multiple records.

Adding and Deleting records

To add a new record to a workfile:
1.
Open the Query menu and click BUILD User WorkFile.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Building WorkFile Configuration Records (Browse) window appears, open the Edit menu and click Insert.

4.
Double-click the new record.

5.
When the Detail window appears, enter information in the blank fields of the new record.

To delete a record from a workfile:
1.
Open the Query menu and click BUILD User WorkFile.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Browse window appears, select the record you want to delete.

4.
Open the Edit menu and click Delete.

To add a new Logistics (RT3) record to a workfile record:
1.
Open the Query menu and click BUILD User WorkFile.

2.
From the Select WorkFile drop-down list, select wf_config.

3.
Create a query XE "query"  to retrieve the records you want displayed.

4.
In the Browse window, double-click the record to which you want to append a new logistics record.

5.
Open the Edit menu and click Add Child Logs.

6.
In the Add Logistics dialog box, specify the number of child logs you want to add and click OK.

7.
Click Log - #.  (# is the number of logistics records associated with the configuration record.)

8.
If there are multiple logistics records, double-click the last record in the list.

9.
When the Detail window appears, enter information in the blank fields of the new record.

To add a new Alteration (RT4) record to a workfile record:
1.
Open the Query menu and click BUILD User WorkFile.

2.
From the Select WorkFile drop-down list, select wf_config.

3.
Create a query XE "query"  to retrieve the records you want displayed.

4.
In the Browse window, double-click the record to which you want to append a new alteration record.

5.
Open the Edit menu and click Add Child Alts.

6.
In the Add Alteration dialog box, specify the number of child alts you want to add and click OK.

7.
Click Alt - #.  (# is the number of alteration records associated with the configuration record.)

8.
If there are multiple alteration records, double-click the last record in the list.

9.
When the Detail window appears, enter information in the blank fields of the new record.

Note:
You can add a JCN/Notes record to the new alteration record by clicking Notes and typing the note in the CDM Remarks text box.

Importing from a 419-Character SDIF XE "standard data interchange format"  File into a Workfile

You can create and edit 419-character SDIF XE "standard data interchange format"  files then import them into CDMD-OA for submission to CDMs.  The Import SDIF Trans command appears in the Options menu of the Workfile Summary and Work Queue windows.  This feature is for loading a small number of transactions (about 1000) and works from both remote sites and Central.

To import an SDIF XE "standard data interchange format"  file:
1.
Open the Query menu and click WorkFile Summary.

Note:
To import to a specific work queue, click Detail and select the work queue.

2.
Open the Options menu and click Import SDIF XE "standard data interchange format"  Trans.

3.
Use the Select File dialog box to locate the file to import.


Example:
C:\Temp\R21822SDF.sdf

4.
Click OK.

Creating a 419-Character SDIF XE "standard data interchange format"  Extract File

The Create SDIF Extract command appears in the Options menu of the Workfile Summary and Work Queue windows.  This feature creates SDIF extracts from the Workfile or queue and works from both remote sites and Central.

To create an SDIF XE "standard data interchange format"  extract file:
1.
Open the Query menu and click WorkFile Summary.

Note:
To create an SDIF file from the workfile, users must have a RAD Mailbox to direct the file to or their own RAD Mailbox.

2.
Open the Options menu and click Create SDIF XE "standard data interchange format"  Extract.

3.
Enter and Appropriate filename, Select the UIC to RADMAIL the file to, and then enter any remarks desired.

4.
Click OK.

The file will be sent via RADMAIL to the UIC designated and may be downloaded from the Available Product using RADCOM/RADWEB. 

Printing Validation Aids from Workfile Records

You can print workfile records in long or short form validation aids XE "validation aids"  to take on board ships and validate equipment.

To print validation aids XE "validation aids" :
1.
Open the Query menu and click BUILD User WorkFile.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
Open the Reports menu and click the type of validation form you want to print.

Validation Aids may also be created from the Browse screen.

Note:
CDMD-OA prints a Validation Aid for ALL records in the Browse window.

Saving Workfiles in Alternative Formats

You can save workfiles XE "workfiles"  in a variety of formats to view with third-party software.  CDMD-OA saves only selected items.

To save workfiles XE "workfiles" , queues, or records in a third-party format:

1.
Create a query XE "query"  to retrieve the items you want.  Be sure to include all the fields you need.

2.
In a Browse window, select the records you want to save to a file.

3.
Open the File menu and click Save As.

4.
Designate where you want to save the file.

5.
Enter a file name.

6.
Select a file type from the Save as type drop-down list.

7.
Click Save.

Changing the Default Workfile

1.
From a Browse window, open the Edit menu and click Set Default Queue.

2.
In the WF Summary Selection window, select the workfile to which you want to copy records.

3.
Click OK.

Note:
CDMD-OA copies records to the selected workfile.  A record’s associated UIC determines the destination queue.

Submitting Workfiles Created Outside of CDMD-OA Using RADCOM

CDMD-OA can send SDIF XE "standard data interchange format"  files to a CDM using RADCOM.  The file goes to Central where CDMD-OA routes it to the CDM responsible for the corresponding UIC’s records.  In CDMD-OA, the data from the SDIF file becomes a workfile with a status of “Hold” until a supervisor, dispatcher, or administrator releases it.  The CDMD-OA Technical Specification contains guidelines for compatible SDIF files.

To submit workfiles XE "workfiles"  created outside of CDMD-OA using RAD mail:
1.
Open the RAD mail program.

2.
Open the RADMailbox menu and click Send RAD Mail.

3.
In the Local File to Mail text box, enter the path of the file to send.

4.
From the RAD User Address list box, select CDMD Central.

5.
From the Product Type list box, select CDM Upline, ISEA Upline or ILO Upline.

6.
In the Description text box, type a descriptive title for the workfile.

Note:
The file must be in SDIF XE "standard data interchange format"  format.

Tip:
The text you type in the Description text box appears in the file description on the CDM’s workstation.  Use a short descriptive title that clearly identifies the workfile; for example, “Ship name” CSRR validation APR 00 FTSCLANT.

Importing SDIF XE "standard data interchange format"  Transactions Using RADCOM

You can use RADCOM to import SDIF XE "standard data interchange format"  transactions to a work queue in Central only.  The Product Type is Central ISEA Upline or Central ILO Upline and the destination is Central-SDIF.  The remarks field must start with the User ID of the person who will own that work summary in Central.
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Clicking the Uc check box allows changes to the Class Functional File across the whole class of ships.

Demonstrate how to release workfiles XE "workfiles"  for processing.

Releasing a workfile from the WorkFile Summary window releases all files in the workfile summary.  To release individual ship files, go the Work Queue screen and click on individual file.

Processing record with action code “C”, change.

Process record with action code “A” (add).

RIC found in ship’s database file.

RIC not found in ship’s database file.

Create CFF XE "class functional file"  record.

Process record with action code “D” (delete).

Discuss non-agree codes.

This is not the recommended way to process workfiles XE "workfiles" .


	Chapter 13 – CDM and Master Data Processing

Chapter Objective – Two Parts

Chapter 13 Part One – Master Data Processing shows students how to:

· Add, change and delete Type 2 Configuration records

· Add, change and delete Type 3 Logistics records

· Add, change and delete Type 4 Alteration records

· Copy Hull-to-Hull

· Perform Global Data Replacement

· GFE/CFE 

Chapter 13  Part Two – CDM Processing shows students how to:

· Release workfiles XE "workfiles" 
· Select records for manual or automatic processing

· Process workfiles

Master Data Processing

Adding, changing and deleting Type 2 Records

To add a new Type 2 Configuration Record in Master Data:
1.
Open the Query menu and click Configuration (2) File.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Selected Configuration records (Browse) window appears, open the Edit menu and click Insert.  The insert icon may also be used.
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4.
Double-click the new record.

5.
When the Detail window appears, enter information in the blank fields of the new record.   

Note:
Ensure that all fields that have mandatory errors (red) are corrected.  Any record that has mandatory errors will not flow through the ASI process.
Tip:
Review the Data Element information found within CDMD-OA's Help file for assistance incorrectly populating all required fields.
To change a Type 2 Configuration record in Master Data:
1.
Open the Query menu and click Configuration (2) File.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Browse window appears, select the record you want to change.  Highlight the field to change and enter the corrected data or  double click on the record and go to the Detail screen to change each field necessary.

Note:
Each time a record is added, changed, or deleted, the Configuration Activity, Reporting Initials and Information Date is updated with the information of the person making the change.
To delete a Type 2 Configuration record from Master Data:
1.
Open the Query menu and click Configuration (2) File.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Browse window appears, select the record you want to delete.

4.
Open the Edit menu and click Delete.  The Delete icon may also be used.
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Adding, changing and deleting Type 3 Records

To add a new Logistics (RT3) record to a Type 2 Configuration record:
1.
Open the Query menu and click Configuration (2) File.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
In the Browse window, double-click the record to which you want to append a new Logistics (RT3) record.

4.
Open the Edit menu and click Add Child Logs.  

5.
In the Add Logistics dialog box, specify the number of child logs you want to add and click OK.

6.
Click Log - #.  (# is the number of logistics records associated with the configuration record.)

7.
If there are multiple logistics records, double-click the one you want to update.

8.
When the Logistics Detail window appears, enter information in the blank fields of the new record.

To change a Logistics (RT3) record:
1.
Open the Query menu and click Logistics (3) File.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Browse window appears, select the record you want to change.  Highlight the field to change and enter the corrected data or double click on the record and go to the Detail screen to change each field necessary.

Note:
Each time a record is added, changed, or deleted, the Configuration Activity, Reporting Initials and Information Date is updated with the information of the person making the change.
To delete a Logistics (RT3) record:

1.
Open the Query menu and click Logistics (3) File.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Browse window appears, select the record you want to delete.

4.
Open the Edit menu and click Delete.  The Delete icon may also be used.

Adding, changing and deleting Type 4 Records 

To add a new Alteration (RT4) record to a Type 2 Configuration record:
1.
Open the Query menu and click Configuration (2) File.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.

In the Browse window, double-click the record to which you want to append a new alteration record.

4.
Open the Edit menu and click Add Child Alts.

5.
In the Add Alteration dialog box, specify the number of child alts you want to add and click OK.

6.
Click Alt - #.  (# is the number of alteration records associated with the configuration record.)

7.
If there are multiple alteration records, double-click the one you want to update.

8.
When the Alteration Detail window appears, enter information in the blank fields of the new record.

To change a Alteration (RT4) record:
1.
Open the Query menu and click Alteration (RT4).

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Browse window appears, select the record you want to change.  Highlight the field to change and enter the corrected data or double click on the record and go to the Detail screen to change each field necessary.

To delete a Alteration (RT4)  record:
1.
Open the Query menu and click Alteration (RT4) File.

2.
Create a query XE "query"  to retrieve the records you want displayed.

3.
When the Browse window appears, select the record you want to delete.

4.
Open the Edit menu and click Delete.  The Delete icon may also be used.

Copy Hull-to-Hull

Copying Configuration (RT2) records Hull-to-Hull

Copying Hull-to-Hull is one of the easiest methods to transfer data from one ship to another.  It may be accomplished with Configuration Records, Alteration Records or Logistics Records and must be preformed from the Browse Screen.

1.
Open the Query menu and click on Configuration (RT2).

2.
When the Browse window appears, select the records you want to copy.  Multiple records may be copied using the CTRL or Shift keys.

3.
Open the Edit menu and click Copy Hull-to-Hull. 

4.
Select one or more Hulls you want to copy the record(s) to.

5.
From the Choose Child Record window, Select Copy Children Type, if you want to Copy Some Children or Copy All Children.  If you select Copy Some Children, the boxes on the No Child Types Available will be highlighted for those children available for copying and listed in the No Specific Types Available.  See Screen .
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6.   If Copy All Children is selected , also click on the  Copy Config UDF, Copy Logistics, Copy Alteration etc. to see the children available for copying .  

7.
The record is then copied to the appropriate Hull with the specified children with an Action Code of A.  Ensure all Mandatory errors are corrected.

Copying Logistics (RT3) records Hull-to-Hull

1.
Open the Query menu and click on Logistics (RT3).

2.
When the Browse window appears, select the records you want to copy.  Multiple records may be copied using the CTRL or Shift keys.

3.
Open the Edit menu and click Copy Hull-to-Hull. 

4.
Select one or more Hulls you want to copy the record(s) to.

5.
From the Assign Logistics Records Parent RIN window, enter the Parent RIN of the Logistics record(s) you are adding.  Correct any errors.

Copying Alteration (RT4) records Hull-to-Hull

1.
Open the Query menu and click on Alteration (RT4).

2.
When the Browse window appears, select the records you want to copy.  Multiple records may be copied using the CTRL or Shift keys.

3.
Open the Edit menu and click Copy Hull-to-Hull. 

4.
Select one or more Hulls you want to copy the record(s) to.

5.
From the Assign Logistics Records Parent RIN window, enter the Parent RIN of the Logistics record(s) you are adding.  Correct any errors.
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Global Replacement of Fields

Global Replacement of (RT2)

1. Create a query to retrieve the records you want to edit.  Be sure to include the appropriate fields for display.

2. Open the Edit menu and click Replace Text.

3. In the Data Replace dialog box, select a field name from the Field to Search drop-down list.

4. Type the text you want to find, or use wildcards in the Search For text box.

5. In the Change To text box, type the new text.

6. Click Change All to replace all instances that match the Search For text. 

OR


Click Search and Verify to confirm each replacement.

Building a Record Type 1 New Construction Query
Ship/Class (RT1) file displays ship level information for all ships or activities in the system.

To build a query for an activity:

7. Open the Query menu and click Ship/Class (1) File

8. At the Selection Criteria window, select the following fields form the activity (primary) table:

· Class

· New Construction

· Ship hull

· Name

· CDM

· Tycom Code

· Snap Type

· Status

Note:  Some of these fields may appear in the field list by default

9. In the Filters column text boxes, type text and/or wildcards to limit the query results.

Note:  Class and Hull have special selection filters that display a table for choosing a class/hull.

Four (RT2) fields are required when New Construction is checked in (RT1.)
10.  Completion of the following (RT2) fields is required:

11. Suppliers Code (SC) – Contractor or Government source.


If this field shows C it means contractor


This field shows the allowed values for SCFLSI DB new construction as follows:

CODE
DEFINITION

A
Group List, including page number

B
Bill of Material, including page number

C
Scratch bill of material, including page number

D
AMRL (Advance Material Requirements List)

E
AEL including preliminary or modified AELs

F
Schedule A

G
Ordnance configuration list

H
Ship’s detail spec, including page number

J
Miscellaneous allowance List number

K
WBS equipment list

P
Purchase order number

R
Contract number

T
Special project number

V
Shipment order number and other


12. Procurement Source Document Number (PSDN) -  identifies document type

13. Procurement Source Document Item Number (PSDIN) – identifies unique item on PO

14. Type Number Code (TNC) – what type of source

Note:  When ROMIS application is used the above method cannot be utilized.

Note:  When CDM/ISEA can input equipment directly into CDMD/OA the above method can be used.

Defined by RIN

CFE (Contractor Furnished Equipment)


7*******

GFE (Government Furnished Equipment)


9*******

Part Two

CDM Processing

How CDMs Receive and Release Workfiles for Processing

The primary generators of workfile transactions are In Service Engineering Agents (ISEA’s), Integrated Logistics Overhaul Teams (ILO’s), Homeport Validation Teams (HVT’s), and ships.  Prior to sending workfiles XE "workfiles"  to a CDM for processing, activities other than ships should notify the CDM of the impending transfer via e-mail.  The message should include the number of add, change, and delete transactions within the file.  The CDM logs on to CDMD-OA and views the workfile in the WorkFile Summary window.  When received, a workfile’s queue status is “Hold.”  A user with Administrator, Supervisor, or Dispatcher rights must change the workfile’s status to “Release” before it can be processed.

Choosing to Update CFF XE "class functional file"  During Workfile Processing

The CDM’s confidence in the origin of files (trusted sites) guides the decision to set workfile records for automatic processing or release them for manual processing.  A record’s Queue Status must be Hold to select and release it for auto-processing.  CDMD-OA error-checks and processes released records selected for automatic processing.  Records not selected for automatic processing release for manual processing.  Releasing work queues requires Administrator, Supervisor, or Dispatcher user rights.

When processing a record, CDMD-OA’s default setting does not allow changes to records that affect the Class Functional File (CFF XE "class functional file" ).  You must authorize changes to the CFF when releasing a record from Hold status.  To allow changes to the CFF, select the Uc check box of the work queue before release.

To select records in a work queue for manual or automatic processing:
1.
Open the Query menu and click WorkFile Summary.

2.
In the Workfile Summary Listing window, double-click a workfile.

3.
In the Work Queue window, double-click a work queue.

4.
In the Manual Review window, select a record’s Proc check box or select multiple records and click Auto.

Tip:
Use <SHIFT> + click or <CTRL> + click to select multiple records.

5.
Click Quit.

6.
In the Work Queue window, select the work queue’s Uc check box if you want to allow changes to the class functional file (CFF XE "class functional file" ) based on records in the work queue.

7.
Click Release.

8.
Click Quit.

Workfile Queue Priority

A workfile’s priority establishes the sort order XE "sort order"  of the workfile’s records in the Browse window.  When you use the BUILD User WorkFile or the PROCESS User WorkFile command, select the Prioritize check box to sort records by assigned priority.  Prioritized records appear in ascending order.

To set the priority of a workfile queue:
1.
Open the Query menu and click WorkFile Summary.

2.
In the Workfile Summary window, double-click a workfile.

3.
Select a work queue.

4.
In the work queue’s Prior field, type a number.

Processing Workfile Records Manually

1.
Open the Query menu and click PROCESS User WorkFile.

2.
Select a predefined Query Name from the drop-down list.

3.
If necessary, edit the Field List by adding and removing items as described in Chapter 5.

4.
Enter filter XE "filter"  criteria in the Filter text boxes.

Note:
To retrieve all records in the workfile for a specific ship/hull that are marked for manual processing, be sure the ship hull (act) field and the processed code (wf_cfg) fields are in the query XE "query" .  Place an “M” in the filter XE "filter"  for the processed code (wf_cfg).  To retrieve a specific workfile, be sure the summary title (wf_sum) field is in the query and type the summary title for that workfile in the corresponding Filter text box.

5.
Select the Retrieve as Needed check box to quicken data display on queries with many records.

6.
Click OK.

7.
In the Browse window, you can sort the workfile records on certain fields to make processing easier.  You can sort on error cd (wf_cfg) to put all non-error records at the top for rapid record processing.  Records highlighted in red (error cd = “M” for mandatory error) or yellow (error cd = “W” for warning error) must be processed manually.  Double-click a record to go to the Detail window.

8.
In the Detail window, edit field data until a record passes the record check XE "record check" .  Instructions for processing change, add, and delete transactions follow.

Note:
Mandatory errors prevent release for upline reporting.  Correct all errors to avoid a lack of support for the system or equipment.

9.
After providing required information in all fields, click Update to process the record.  The proc cd changes to “P”.  To view the current record with changes, click Curr.

Processing Change Transactions

To change information on the master database records, submit workfile records with action code “C” (change transactions).  On change transactions, fields differing from the master database record appear in green text.  The CDM must determine that changed fields meet SCLSIS XE "SCLSIS"  Technical Specification requirements before processing the record.

To view a record in the master database from a workfile record:
Viewing the master database copy of a workfile record before processing allows you to assess the impact of the changes.  Viewing the records changes history helps determine the correct values for various fields.

1.
In the Detail window, click Curr to view the current database record.

2.
To view a history of changes to the current database record, right-click anywhere in the record, point to History and click Record History.

3.
Click Quit to close the Work Queue History window.

To compare a workfile record to the master database record:

Comparing a workfile record to the master database record before processing allows you to identify changes to the record.  You also can process class functional file (CFF XE "class functional file" ) changes by selecting the Updt check box in the (Compare) window.

1.
In the Detail window, click Cmp to view a list of changes including workfile values and master database values.

2.
Leave the Updt check box clear to overwrite the value in the workfile record with the value from the master database when the record updates (default).


OR

Select the Updt check box to change the master database to match the workfile record.

3.
Click Quit to close the (Compare) window.

4.
In the Processing Workfile window, click Update to process the record.

Note:
You can use the Updt feature only if a user with appropriate rights has authorized it for the work queue containing the record.  You can view the current copy of the workfile record in the master database or view a history of changes made to the record to help determine the correct values to enter, as described previously.

Processing Add Transactions

Submission of workfile records with an action code of “A” (add) add new or missing records to the master database.  Prior to processing add transactions, the CDM should search the ship’s file in CDMD-OA to determine if the RIC is in the file.  If the RIC is not in the ship’s file, the record is a justified add.  Verification for each occurrence of the RIC in the workfile is unnecessary.  If the RIC appears in the database, you can compare fields to determine if the record was added previously, then change the workfile TRIN to the permanent RIN.

To change a record’s RIN in a workfile:
1.
Open the Query menu and click Process User WorkFile.

2.
Build a query XE "query"  to retrieve the records you want.

3.
In the Browse window, double-click a record.

4.
From the Detail window, open the Edit menu and click Change Rin.

5.
In the RIN Search window, use the fields in the Search Criteria group to set search criteria.

Note:
The available search criteria come from the existing record.

6.
Click Search.

Note:
CDMD-OA searches the primary database for records that match the selected search criteria.  If the RIC is not in the ship’s database, you must add it.  Search across all ships in the class to identify a hierarchical structure code (HSC) in the class functional file (CFF XE "class functional file" ) record, as described following this procedure.

7.
To change the record’s RIN to match one found by the search, select a record’s row from the list and click Apply.

8.
Click Quit to close the RIN Search window.

9.
Click Update to process the record.

Note:
CDMD-OA automatically applies an “M” (RIN migration) to the non-agree cd field.  See Understanding Non-Agree Codes later in this chapter.)

To Query the Configuration (2) File and Identify an HSC:
1.
Open the Query menu and click Configuration (2) File.

2.
Select al hull’s in the ship’s class.

3.
Select the RIC you want displayed.

4.
Click OK.

If the RIC appears on other hulls, the HSC exists and you can insert it into the ship’s workfile record.  Verify the remaining fields on the workfile record and click Update to process it.

If the RIC does not appear on any other hull in the class, you must create a CFF XE "class functional file"  record before processing the workfile.  From the information provided on the transaction, determine to which system the component belongs, for example, propulsion, command and control, or weapons.  Next, determine the importance of the component within the system.  If it is the most important element of the system, it should appear at the head of a top-down arrangement of components.  If the component plays a supporting role in the system, it appears further down.  For example, a pump, motor, or controller should appear in the middle of a top-down arrangement, followed by various valves, gauges, circuit breakers, and connection boxes.  SCLSIS XE "SCLSIS"  Technical Specification 9090-700C contains HSC information.

After establishing the HSC, completing the CFF XE "class functional file"  record requires several additional data elements.  The equipment functional description (EFD) and equipment system designator (ESD) describe the component’s use and related system.  For example, No. 1 Fire Pump Motor is and EFD, while Fire & Flushing System is an ESD.  The planning yard and in-service engineering agent are excellent sources of information for completing these fields.  Ship’s installation drawings (SID), ship information books (SIB), technical manuals, and the engineering operating sequencing system (EOSS) are additional sources of information.  The service application code (SAC XE "service application code" ) groups systems and equipment by service application.  You can find the SAC in the CDMD-OA reference library.  The mission essentiality code (MEC) and mission criticality code (MCC) designate the importance of the system or equipment to the ship’s mission.  The MEC is generally “V” (Vital: Failure of the equipment/component would result in degradation of mission) except for FBM/TRIDENT submarines.  The CDM assigns the MCC based on input from the planning yard and ISEA.

To add or change a class functional file (CFF XE "class functional file" ) record:
1.
Open the Query menu and click Class Functional File (CFF XE "class functional file" ).

2.
In the Selection Criteria window, select the ship class.  Type the ESWBS XE "expanded ship work breakdown structure"  in the hsc (cff) field, ending with the asterisk (*) wildcard.  For example, 47111*.

3.
In the Browse window, select the HSC that describes the component to add and copy it, <CTRL> + <C>.


OR


If there is no HSC that describes the component, select an HCS, then open the Edit menu, click Insert, and type a new HSC.  Select and copy it, <CTRL> + <C>.

4.
Click OK.

5.
Return to the workfile and paste, <CTRL> + <V>, the HSC into the HSC field.

6.
Click Update to process the record.

Processing Delete Transactions

Submit workfile records an action code of “D” (delete) to delete records for equipment removed from a ship.

To process a delete transaction:
1.
Open the Query menu and click Process User WorkFile.

2.
Build a query XE "query"  to retrieve the records you want.

3.
In the Browse window, double-click a record.

4.
In the Detail window, click Update.

To release delete transactions for auto-processing:
1.
Open the Query menu and click WorkFile Summary.

2.
In the Browse window, double-click a workfile.

3.
Select the records with an action code of “D” that you want to delete and click Auto.

4.
Click Quit.

5.
In the Detail window, click Release.

6.
Click Quit.

Understanding Non-Agree Codes

All workfile records must be processed to clear outstanding Job Control Numbers (JCN) from the ship’s SNAP.  At times, the CDM may not agree with the workfile record.  CDMs can use non-agree codes to process workfile records.

To process workfile records using a non-agree code:
1.
Open the Query menu and click Process User Workfile.

2.
Build a query XE "query"  to retrieve the records you want.

3.
In the Browse window, double-click a record.

4.
In the Detail window, select the applicable code from the Non-Agree Cd drop-down list.

5.
Click Update and type a reason for the non-agree code in the comment box that appears.

6.
Click Save.

Non-Agree Codes
N
Non-Concur – Erroneous Update
Select Non-Concur when you do not agree with a transaction.  A transaction to reverse the operation returns to the ship.  For example, an Add record returns a Delete transaction, Change or Delete returns current CDMD-OA data.

I
Insufficient Info TRIN – TRIN delete
Select Insufficient Info TRIN when you receive a transaction from the ship that has a TRIN but not enough information to be processed.  Usually these are Add transactions from the ship.  A delete transaction returns to the ship.

C
Insufficient Info – Data Corruption
Select Insufficient Info – Data Corruption when you receive a transaction with a RIN that is not in the database and if you cannot identify the equipment.  A Delete transaction returns to the ship.

U
Delete in Error – Reinstatement

Select Delete in Error when you receive a transaction for a RIN deleted in error.  The transaction restores and updates the master database record.  This normally happens in response to a change transaction for the ship.

D
Already Deleted – Re-Delete
Select Already Deleted when the ship sends a transaction for a record previously deleted by the CDM.

M
RIN Migration
CDMD-OA applies RIN Migration automatically when a CDM changes a RIN associated with a record.  The transaction updates the RIN in the master database.  If the transaction does not contain a JCN page, CDMD-OA sends a delete transaction to the ship for the original RIN.

X
Convert RT 2 to RT 4 (or 4 to 2)

Select Convert RT 2 to 4 when the ship sends a configuration transaction (RT 2) that should be an alteration transaction (RT 4).  CDMD-OA creates an alteration transaction using data from the transaction the ship sent.  Select Convert RT 4 to 2 when the ship sends an alteration transaction that should be a configuration transaction.  If the transaction does not include a JCN page, a delete transaction returns to the ship.

Processing a Workfile Record Using Workfile Summary

1.
Open the Query menu and click WorkFile Summary.

2.
In the Workfile Summary Listing window, double-click a workfile.

3.
In the Work Queue window, double-click a work queue.

4.
In the Manual Review window, select record type 2 XE "record type 2" , 3, or 4 from the Rec drop-down list.

5.
Select a record and click Detail.

6.
Edit the record, if necessary.

7.
Click Rec Chk.

8.
Click Update.

Note:
A record must have a queue status of Release for you to update it.
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	Chapter 14 – Using CDMD-OA Online Help

Chapter Objective

Chapter 14 shows students how to use the CDMD-OA online Help.  It also explains the program’s edit check functions.

Online Help

Purpose

The CDMD-OA Help file XE "Help file"  explains the functions, logic, and operation of the program.

Using the Help File

Open the Help menu and click Help Contents or click the Help button [image: image95.bmp] on the toolbar.

The Help Topics window includes three tabs:

Contents
Double-click a “book” icon to see a list of topics.  Double-click a “question mark” icon [image: image96.jpg]


 to view the associated topic.

Index
Type the word you want to find in the text box at the top of the tab page.  Click the index entry you want, then click Display.

Search
1.
Type the word(s) you want to find in the text box at the top of the tab page.

2.
Select some words to narrow your search from the list box in the center of the tab page.

3.
Click a topic in the lower list box, then click Display.

Getting Started

An online training guide to CDMD-OA.

Using the Tech Spec Definitions

The CDMD-OA Help file XE "Help file"  includes field definitions from NAVSEA Technical Specifications 9090-700(series).

To view Tech Spec definitions:
1.
Open the Help menu and click Tech. Spec. Definitions.

2.
Click a topic from the list of fields to see a detailed description to the field and requirements for its use.

Note:
The list of field descriptions has four alphabetically divided sections.  Use the blue buttons under the topic title to access other sections of the list.

Tip:
The list of all fields… link provides a list of the fields you can use to create an ad hoc query XE "query" .  The list includes a button for each field that links to a list of tables containing the field.  It also has a button that links to a list of all tables you can query.

CDMD-OA Edit Checks

CDMD-OA checks the content of fields in the following tables:

· Configuration table records (RT2)

· Logistics table records (RT3)

· Alteration table records (RT4)

· Work file configuration table records (RT2)

· Work file logistics table records (RT3)

· Work file alteration records (RT4)

· Class functional file (CCF XE "component characteristics file" ) table records

· XRIC reference table records

Edit checks can affect data processing and storage.  The following considerations apply:

· Constraints are requirements a record must meet to enter the database.

· Warning edit checks identify fields with inconsistent data and appear as yellow text in the Detail window.

· Mandatory edit checks are CDMD-OA requirements.  Fields with mandatory errors appear as red text in the Detail window.

Note:
The edit checks applied to a field can change depending on the table with which the field is associated.  For example, the edit checks applied to a field entered in the configuration table are more stringent than those applied to the field when entered into the workfile configuration table.

To learn more about CDMD-OA edit checks:
· Open the Help menu and click Edit Chk Descriptions.

Table Definitions

Open the Help menu and click Table Definitions to view a list of tables that contain fields subject to ad hoc queries.  The topic also includes links to an alphabetical list of all fields and the tables in which each field appears.

Reference Library Button
[image: image97.bmp]
Click the Reference Library button to view a list of CDMD-OA reference tables.  Select a table from the list to view its contents.

Note:
The CDMD-OA reference tables are not a part of the CDMD-OA Help file XE "Help file" .

Contacting Technical Support and Receiving Product Updates

To report a suspected program bug, suggest an enhancement, or track reported issues, use CDMD-OA’s AutoSIRs feature, as described in Chapter 11.

The CDMD-OA Web site allows you to do the following:

· View Knowledge Base items posted by CDMD-OA’s development team

· Post or read articles in CDMD-OA’s online user forum

· View an interactive Web-based tutorial

· Download program updates

· Download troubleshooting utilities

· View an FAQ and list of troubleshooting tips

· Check the status of a tech support request

For additional program support, call CDMD-OA Tech Support, NSLC Pacific, (904) 759-4065.




Appendix A – Wildcards

	Wildcard


	Description
	Example

	*
	Use an asterisk at the end of text strings to represent any character or number of characters that may follow a string.
	In the field being searched, win* selects all records that begin with “win”.  For example, records containing “windows” or “wind,” but not “rewind”.

Note:
Do not use an asterisk with the “not equal to” (<>), “less than or equal to” (<=), or the “greater than or equal to” (>=) wildcards XE "wildcards"  because these queries typically display no rows.



	@
	Use an ampersand before a string to return all records with a matching character string anywhere in the field.
	In the field being searched, @RAD selects all records with “RAD” anywhere in the selected field.  For example, records containing “radio,” “radar,” or “radiation monitor”.



	<>
	Use the “not equal to” symbol before a text string or numeric value to select all records that do not match the string or value.


	In the field being searched, <>RADIO selects all records that do not contain “radio”.

	<=
	Use the “less than or equal to” symbol before a text string or numeric value to select all records less than or equal to the search criteria.


	In the field being searched, <=15 selects all records that contain a value of “15” or less.

	>=
	Use the “greater than or equal to” symbol before a text string or number value to select all records equal to or greater than the search criteria.


	In the field being searched, >=15 selects all records that contain a value of “15” or greater.

	?
	Use a question mark in a text string as a placeholder to represent any character.


	In the field being searched, wo?d selects all records with “wo” as the first two characters, any character in the third position, and “d” as the fourth character.

	Wildcard


	Description
	Example

	,
	Use a comma between two search criteria to represent an explicit OR.


	In the field being searched, 639,640 selects all records having 639 or 640.

	;
	Use a semicolon between two search criteria to represent an explicit AND.


	In the field being searched, RIN 8*;<>8AD5Z selects all records with a RIN starting with 8 but not 8AD5Z.


Appendix B – Glossary

80366A


Output File from Shipbuilder’s Mainframe

ADP


Automated Data Processing

ADPY


Aegis Destroyer Planning Yard

AEL


Allowance Equipage List

AINAC


Application/Identification Number Activity Code

APL


Allowance Parts List

ASI XE "automated shore interface" 


Automated Shore Interface

AU


Automatically Generated (auto-generated RT3s)

BAIM


Baseline Automated Industrial Management

BLOB


A data type used to store an unbounded amount of data

C14 XE "C14" 


Configuration Transaction File, used to update WSF


CCB


Configuration Control Board

CCF XE "component characteristics file" 


Component Characteristics File

CDM


Configuration Data Manager

CDMD


Configuration Data Managers’ Database

CDMD-OA

Configuration Data Managers’ Database-Open Architecture

CFCBI


Class Functional Configuration Baseline Index 

CFF XE "class functional file" 


Class Functional File

CIM


Configuration Item Manager

CK


Configuration Change Form (4790-CK, also known as Charlie Kilo)

CM


Configuration Management

COP


Configuration Overhaul Planning

CRMA


Centralized ROMIS Maintenance Activity

CSMP


Current Ships Maintenance Plan

CVN


Aircraft Carrier (Nuclear Propulsion)

DBMS


Database Management System

DBR


Database Reconciliation

DEU


Data Encryption Unit

DLL


Dynamic Link Libraries

E52 XE "E52" 


Allowance Triggers (Data Files), used by NAVICP E52 process

EB


Electric Boat

EFD


Equipment Functional Description

EIC XE "equipment identification code" 


Equipment Identification Code

ERD


Entity Relation Diagram

ESD


Equipment System Description

ESWBS XE "expanded ship work breakdown structure" 

Expanded Ship Work Breakdown Structure

FBM_MEC

Fleet Ballistic Missile Military Essentiality Code

FCBI


Functional Configuration Baseline Index

FGC


Functional Group Code

FMPMIS

Fleet Modernization Program Management Information System

FTP


File Transfer Protocol

FTSCLANT

Fleet Technical Support Center Atlantic (formerly called NAVSEACENLANT)

FTSCPAC

Fleet Technical Support Center Pacific

GUI


Graphical User Interface

HSC 


Hierarchical Structure Code

HUI


Hierarchical Structure Unit Identifier

ILO


Integrated Logistics Overhaul

ILR


Integrated Logistics Review

INMARSAT

International Maritime Satellite Corporation

ISEA


In-Service Engineering Agent

JCN


Job Control Number

JSR


Job Summary Reports

LAN


Local Area Network

LF


Is a Value for DOVC Field (other activity installed)

LSD XE "logistics support document" 


Logistics Support Document

LSRI


Logistics Support Request Indicator

MAMS


Materials and Management System

MCC


Mission Criticality Code

MCSA


Micro-Computer Configuration Status Accounting

MDI 


Multiple Document Interface

MEC


Mission Essentiality Code

MRMS


Maintenance Resource Management System

NAVICP

Naval Inventory Control Point

NAVMASSO

Naval Management Systems Support Office

NAVSEA

Naval Sea Systems Command

NC


New Construction

NCTS


Naval Computer and Telecommunications Station

NDE


NAVSEA Data Environment

NNPI


Naval Nuclear Propulsion Information

NSLC Pacific

NAVSEA Logistics Center Detachment Pacific

NSWC


Naval Surface Warfare Center

OMMS-NG

Organizational Resource Management System – Next Generation

OS


Operating System

PL


Programmable Logic

PMS


Preventative Maintenance System

PRID


Positional Reference Identification

PSA


Post Shakedown Availability

RAD


Revised Alternative Data Flow

RADCOM

Revised Alternative Dataflow Communications

RAID


Redundant Array of Independent Disks

RAM


Random Access Memory

RIC


Repairable Identification Code

RIN


Record Identification Number

ROMIS


Real-Time Outfitting Management Information System

RT


Record Type

RT 1


Record Type 1 – Ship/Class Record

RT 2


Record Type 2 – Component/Configuration Record

RT 3 


Record Type 3 – Logistics Record

RT 4


Record Type 4 – Alteration Record

RT 5 


Record Type 5 – Job Control Number/Nameplate Record

SAC XE "service application code" 


Service Application Code

SCAT


Subcategory Code

SCLSI


Ship Configuration and Logistic Support Index

SCLSIS XE "SCLSIS" 

Ship Configuration and Logistic Support Information System

SCN


Ship Construction New

SDIF XE "standard data interchange format" 


Standard Data Interface Format

SH


Ship Totals (ship totals from a new counts module)

SMP


Symmetric Multiprocessing

SNAP


Shipboard Non-Tactical ADP Program 

SPAWAR

Space and Naval Warfare Systems Command

SQL


Structured Query Language

SSN


Submarine (Nuclear Propulsion)

TGI


Task Group Instructions

TMA


Technical Management/Analysis (company)

TNC


Type Number Code

TOMCAT

Total Onboard Material Configuration Audit Tool

TRIN


Temporary Record Identification Number

TYCOM

Type Commander

UC


Update Class

UDF XE "user defined field" 


User Defined Fields

UIC


Unit Identification Code

USCG


United States Coast Guard

V09


Weapons System File Upload Automated Data System

VALAID

Validation Aid

WCT


Wang Configuration Tracking

WSF


Weapons System File

X-RIC XE "X-RIC" 


Pseudo Repairable Identification Code

Appendix C – Labs

	Things to stress…

Click on a table to select the fields you need.  Always start with Activity table and select Ship Hull.  

The Config and ref_cff are the most widely used tables.

Use Help to find what fields are in which tables.  To do this, go to Help, Index and type in fields, then click display.

Save a query XE "query"  with a ship hull that you’ll be using a lot right away so you don’t have to go through reselecting all the time.  

Advise students that they may put an entire class of ships, ships in a certain homeport and ships within a Battle Group.


	Lab Problem 1 - Building Effective Queries (Assign a SHIP to each student)

Go to the Configuration (2) ADHOC query XE "query"  screen and REMOVE ALL
Add the following fields

· Ship Hull (ACT)

· RIN, RIC, HSC, SERIAL NUMBER, LOCATION, EIN, WCRE  (Config)

· EFD, ESD (ref-CFF) 

Move the following fields

· ESD under HSC

· EFD under ESD

Set the SHIP HULL filter XE "filter"  for X (X = Ship assigned by instructor)

Save the ad hoc query XE "query"  as your firstname lastinitial (alberte)



	Hints:

Use the Ship/Class (1) File menu option to determine the ship-hull number and UIC.  Type in @(Ship Name) in the name(act) filter XE "filter"  cell.

Or sort the ship hull by clicking the Sort button and using activity name, then look up (Ship Name).

Use HELP menu option to look up the definition and allowed values for ISC.  Use P in the ISC filter XE "filter" .
	Lab Problem 2
Using the Installation Status Code (ISC), get a list of all CONFIRMED PLANNED EQUIPMENT INSTALLATIONS for a ship*.  (*Ship assigned by instructor)



	TEST TO ENSURE QUERY STILL WORKS.

Click on Query then Logistics (3) File.

At the Selection Criteria screen, click on lsd serial number (log) and type in 302-7087005.

Fill in the Ship hull (act) filter XE "filter" .

LSD XE "logistics support document"  DESC: PWR SYS MODS INCID SINGLE ARM BOAT DAVIT INSTLN

LOGISTICS RIN:  00K6V

PARENT RIN: 00K6T


	Lab Problem 2 (second 2)
Build a query XE "query"  using DRAWING NUMBER (LOGISTICS SUPPORT DOCUMENT {LSD XE "logistics support document" } SN) 302-7087005 to find an equipment record on the LPD 14 (LPD 4 CLASS).

· WHAT IS THE LSD XE "logistics support document"  DESC?

· WHAT IS THE LOGISTICS RIN?

· WHAT IS THE PARENT RIN?



	Hint:

Use Help, look up ‘FC’, and determine what table and fields are involved.  

Use the Alteration (4) File menu option and build a query XE "query" .

Include alt XE "alt" _type (alt) field in your query XE "query"  and a ship hull.


	Lab Problem 3
How many Field Changes (FC) are on your assigned ship?



	Query on the Configuration (2) File

Click on  Ship Hull (act).
At the next screen click on Class, find the DDG-51 CLASS and click on it. Click OK. Double click on DDG-55.
Click on Ric (cfg) filter. Type in 00022617.

Click OK.
Click on DETAIL.

No. of records = 1

RIN = 0193E

No. of Logistics Records = 5

No. of Parts = 29

Unit price of line item no. 5 = $4390.00

Name of ship = USS STOUT

No. of JCN’s = 1

Query of 00022617* = 00022617, 00022617FA, 00022617FB, 00022617FC.

Of the active ships in the class, 9 have RIC 00022617, 4 have RIN’s that begin with “0”
	Lab Problem 4

Build a configuration query to find RIC 00022617 on the DDG-55 (DDG-51 CLASS)

· How many records with RIC 00022617 does DDG-55 have?

· What is the Record Identification Number (RIN) for this record?

· How many logistic records does this RIN have attached?

· How many Parts are associated with this RIC?

· What is the unit price of line item no. 5 on the parts list?

· What is the name of DDG-55?

· How many JCN’s are attached to this record?

What happens if you query on RIC 00022617*?

How many active ships in the class have this RIC?

How many of these have RIN’s that begin with “0”?


	Query on the Configuration (2) File

Click on  Ship Hull (act).
At the next screen click on Class, find the DDG-51 CLASS and click on it. Click OK. Double click on DDG-67.

Locate ISC(cfg) (Installation Status Code) on the Config. Table and click to move it for use on the query.

While your cursor is still in the ‘filter’ side of ISC, click on the “?” icon in the tool bar.

Scroll down and determine the correct ISC value to use to select:

Confirmed Planned Equipment 

Installation “P”

Planned Equipment Removal “E”

Type these values in the filter side using a comma as a wildcard (indicating OR) to separate the P,E.

Note: Since the database is dynamic, the numbers will not be consistent from day to day.
	Lab Problem  5
Build a query using ISC to determine the number of CONFIRMED PLANNED EQUIPMENT INSTALLATIONS and PLANNED EQUIPMENT REMOVALS on    DDG-67.

· Use HELP to determine correct ISC values.

· Use OPTIONS  on the menu bar and select Display Counts Only to find the number of records in question.



	Query on the Ship/Class (1) File.

In the Name (act) filter XE "filter" , type in USS BATAAN.  Note: This field is CASE SENSITIVE and MUST be typed exactly as listed in the Ship/Class Table.  If you're not sure how to spell a ship’s name, use a wildcard, example, USS B*.

Click on DETAIL screen to obtain remaining information.

Hull Number = LHD 5

UIC = R21879

SNAP Type = SNAP 1

This will fluctuate: Configuration 67271

CDM = NF (NSY Norfolk – look up using Help- Index – Type in CDM – Select Tech Spec)

TYCOM = 12 – look up by right clicking mouse, Help – Window Help, Select Table: Activity, then TYCOM Code.


	Lab Problem 5 (second 5)
Build a query XE "query"  (Ship/Class (1) File) to find the HULL NUMBER for the USS BATAAN {Name (Act)}.

· What is the Hull Number?

· What is the UIC for the USS BATAAN?

· What SNAP Type does the USS BATAAN have?

· How many Configuration Records does the USS BATAAN have?
· Who is the CDM?
· Who is the Type Commander?


	Query on the Ship/Class (1)

Click on  Ship Hull (act).
At the next screen click on Class, find the DDG-51 CLASS and click on it. Click OK. Double click on DDG-57.
Click OK.
Click on DETAIL.

Ship Name = USS MITSCHER

SNAP Type = OMMS-NG

CDM = BA (Bath Iron Works – look up using Help- Index – Type in CDM –Select Tech Spec)

TYCOM = 12 – look up by right clicking mouse, Help – Window Help, Select Table: Activity, then TYCOM Code.

These are approximate: Configuration 32305, Logistics 57745, Alteration 4266
	Lab Problem 6 
Build a Ship/Class (1) query to find Ship Hull DDG-57 (DDG-51 CLASS)

· What is the ship’s name?

· What SNAP Type does the DDG-57 have?

· Who is the CDM?

· Who is the Type Commander?

How many Configuration, Logistics and Alteration records are assigned to this ship?


	Hint:

Use Logistics (3) File menu options to build your query XE "query" .

Use lsd_type (log) and lsd_serial_number (log), include ric (cfg). 

Use LPD 8 in Ship Hull.

RIC 450030032 is a boiler water level indicator and there are 2 onboard.


	Lab Problem 7 (was 5)
I am aboard the LPD 8 and have TM 0951-LP-015-5010.  What equipment RIC does this Tech manual support?  How many are aboard the ship?



	TEST TO ENSURE QUERY STILL WORKS.

Click on Query then Logistics (3) File.

At the Selection Criteria screen click on lsd serial number (log) and type in SE251-HF-MMA-010.

Fill in the Ship hull (act) filter XE "filter" .

Number on Logistics Records: 6

Number of Configuration Records: 6

NHA = AN/SPS-55
	Lab Problem 8 (was 11)
Build a query XE "query"  using TECHNICAL MANUAL NUMBER SE251-HF-MMA-010 to find an equipment record on the CG 53 (CG 47 CLASS).

· HOW MANY LOGISTICS RECORDS HAVE THIS TM?

· HOW MANY CONFIGURATION RECORDS HAVE THIS TM ATTACHED?

· WHAT IS THE NEXT HIGHER ASSEMBLY (NHA) ON THE CONFIGURATION RECORD FOR LOGISTICS RIN 99UPE?



	TEST TO ENSURE QUERY STILL WORKS.

Click on Query then Logistics (3) File.

At the Selection Criteria screen, click on lsd serial number (log) and type in 302-7087005.

Fill in the Ship hull (act) filter XE "filter" .

LSD XE "logistics support document"  DESC: PWR SYS MODS INCID SINGLE ARM BOAT DAVIT INSTLN

LOGISTICS RIN:  00K6V

PARENT RIN: 00K6T


	Lab Problem 9 (was 12)
Build a query XE "query"  using DRAWING NUMBER (LOGISTICS SUPPORT DOCUMENT {LSD XE "logistics support document" } SN) 302-7087005 to find an equipment record on the LPD 14 (LPD 4 CLASS).

· WHAT IS THE LSD XE "logistics support document"  DESC?

· WHAT IS THE LOGISTICS RIN?

· WHAT IS THE PARENT RIN?



	BEGIN BY CREATING A TEXT FILE LISTING ALL THE RICS, THEN IN THE ‘RIC’ FIELD ON THE CONFIGURATION QUERY SCREEN, ENTER [FILE] IN THE FILTER.

At the Query Screen, click on Utilities, then Notepad.  Type a list of RICs (one per row).  Click on File, and then Save.  Name the file RIC.txt.  Exit out of Notepad.

Click on Query, then Configuration (2) File.  In the ship hull (act) field, input the DDG51 – DDG56 ships (Click in the filter XE "filter"  field, then click Class.  Find and click on DDG51.  Click OK.  Click on DDG51, hold down shift key and click on DDG56.  Click OK.) 

In the RIC (cfg) filter XE "filter" , type [FILE].  A screen will appear.  Click on IMPORT, and then find the file RIC.txt.  Double click.  You will see the list of RICS.  Click CLOSE.  The [FILE] filter will be highlighted.  Click on OK or the Enter key.

Note:  To determine how may are on each ship, double-click in the Ship Hull (act) field to index on Ship Hull.  Double-click in the Ric(cfg) field to index on RIC to determine how many RICs.


	Lab Problem 10 (was 4)
I HAVE 10 RICS THAT I WANT TO QUERY, THE DDG51 - DDG56, TO SEE HOW MANY (IF ANY) ARE ON EACH SHIP.  THE RICS ARE:  420310015, 212102193, 381050315, 00019437, 58139421, 151205623, 612010078, 430160326, 00006622, and 31403095.
· BUILD ONE QUERY TO SEARCH FOR ALL THE RICS ON THE DDG51 THROUGH DDG56.

· FROM THIS QUERY, HOW MANY TOTAL CONFIGURATION RECORDS DO YOU HAVE?

· FROM THIS QUERY, HOW MANY RECORDS ARE ON EACH SHIP?



	Click on Query then Alteration (4) File.

Determine the Ship Hull and input it.

Click on the Alt Type (alt XE "alt" ) and type in OA.

Click on the Alt ID (alt XE "alt" ) and type in @30463.  (Note: Some CDMs include a ship’s Class in the ALT ID.)

(UIC R21880 is the LSD XE "logistics support document"  50)

ALT Status: D = Accomplished according to designated NAVSEA authority.

ALT RIC = 0R30463059

ALT Parent RIC = 006090250

ALTS connected to Parent RIC = 3

Location = 04-16-0-C


	Lab Problem 11 (was 13)
Build a query XE "query"  using ORDNANCE ALTERATION 30463 to identify a CONFIGURATION RECORD on a ship with a UIC of R21880.

(ALT TYPE:  OA, ALT ID NBR:  @30463)

· WHAT IS THE ALT STATUS AND WHAT DOES IT MEAN?

· WHAT IS THE ALT RIC?

· WHAT IS THE PARENT RIC?

· HOW MANY ALTERATIONS ARE CONNECTED TO THE PARENT RIC?

· WHAT IS THE LOCATION OF THE EQUIPMENT?



	
	

	TEST ON SHIPS BEFORE ASSIGNING TASK

Hint:

Use reference table ESWBS XE "expanded ship work breakdown structure"  to determine ESWBS of SATELLITE NAVIGATION systems (eswbs_nom: @SATELLITE NAVIGATION) to find 42315 on assigned ship.

At the Configuration (2) query XE "query" , insert ship hull then put 42315* in the HSC filter XE "filter"  block.

Can also use  @NAVIGATION in the EFD or in the RIC Nomenclature.


	Lab Problem 12 (was 2)
Find the ESWBS XE "expanded ship work breakdown structure"  code for a SATELLITE NAVIGATION (system) on a ship* class.  (*Ship assigned by instructor) 

Use the ESWBS XE "expanded ship work breakdown structure"  to determine what type of SATELLITE NAVIGATION is on your assigned ship.  Then pull up the top-down breakdown of ALL the components of the SATELLITE NAVIGATION system.



	TEST TO ENSURE QUERY STILL WORKS.

Click on Query then Logistics (3) File.

At the Selection Criteria screen click on lsd serial number (log) and type in SE251-HF-MMA-010.

Fill in the Ship hull (act) filter XE "filter" .

Number on Logistics Records: 6

Number of Configuration Records: 6

NHA = AN/SPS-55
	Lab Problem 13
Build a query XE "query"  using TECHNICAL MANUAL NUMBER SE251-HF-MMA-010 to find an equipment record on the CG 53 (CG 47 CLASS).

· HOW MANY LOGISTICS RECORDS HAVE THIS TM?

· HOW MANY CONFIGURATION RECORDS HAVE THIS TM ATTACHED?

· WHAT IS THE NEXT HIGHER ASSEMBLY (NHA) ON THE CONFIGURATION RECORD FOR LOGISTICS RIN 99UPE?



	On the Configuration (2) File:

Click on the “COPY” button located on the right hand side of the query screen, open the dropdown menu and select  (N65912MLM).

From the selections appearing in the box at the left, select “Active ESWBS’s” and press OK.
Upon returning to the query screen, click in the Ship Hull filter, press the Class button, select AOE-1 class and press OK. Select ALL and press OK.

Unfold the OPTIONS fold down and select Unique Records. Press OK.
Save the resultant browse list as a .txt file in Briefcase for further use. Name the file “aoe1eswbs”.

Unfold Query on the menu bar and select References then ESWBS Nomenclature. Use the Default query, click in HSC Class filter and select AOE-1. Click OK. 

In the filter for ESWBS type [FILE] and move your mouse pointer and when the Import Filter window opens press IMPORT. Select Briefcase and designate the file you have previously saved and click OPEN. When notified how many rows have been copied, click Quit and wait while the data is copied.

When finished click OK.
Scroll through the resultant Browse list
	Alternate Lab Problem  14
You have determined that you have a need to examine the ESWBS’s and ESWBS Nomenclature for the ESWBS’s that are currently in use on the AOE-1 Class.

· Copy a Configuration query already prepared for this purpose by a team member.

· Select all the hulls associated with the AOE-1 Class.

· Use the Options dropdown menu to select ‘Unique Records’.

· Save a text file and use in conjunction with the [FILE] function to perform a search.


	Click on Query then References.

Click ESWBS XE "expanded ship work breakdown structure" . 

Prepare a query XE "query"  to include ESWBS XE "expanded ship work breakdown structure"  and ESWBS Nomenclature.  In the ESWBS Nomenclature filter XE "filter" , type in @AN/UQN-4.

The ESWBS XE "expanded ship work breakdown structure"  is 42404.


	Lab Problem 15

Build a query XE "query"  to identify the ESWBS XE "expanded ship work breakdown structure"  for an AN/UQN-4.




	Create a Configuration query XE "query" , and then copy selected records to a work queue.  Cover all options such as:

Set Default Queue

Copy to Queue

Add new record to Queue

Delete Record from Queue

Globally replace data

Change data.

Copy hull to hull.  (You may want to ensure you have the ship’s UIC or hull field listed so that you can see it actually does copy to a new hull.  Include the RIN also.)

Try CG-47 with an HSC filter XE "filter"  of 41111 as example.


	Lab 2 - Problem 1

Building Work Queues

· The purpose of this exercise is to walk you through the process of finding records in the database and then copying them to the workfile area where you can then edit them and/or copy them to a different hull.

· Typically, when you finished your workfile, you would ‘Submit’ it to the CDM for processing into the Master Configuration Data.  However, during training, we will NOT be submitting workfiles XE "workfiles" .

Remember, during this exercise we will not be submitting any workfiles XE "workfiles" .



	Let students work on their own for awhile on this lab.

Walk around room to ensure all students have grasped this procedure.

Assist when/where needed.


	Lab 2 – Problem 2

1.
Build a CONFIGURATION query XE "query"  and retrieve a set of configuration records from a system and the ship assigned to you.

2.
Select two to three records from the result set and COPY them TO a new user work QUEUE (use multiple UICs and select DDG 57).

Note:
If Work Queue previously opened, must SET DEFAULT QUEUE to establish new Work Queue.

3.
Review your records using the WORKFILE SUMMARY menu option.

4.
Retrieve the specific records in your queue using the BUILD USER WORKFILE menu option.

5.
Copy your records to the next ship in the class.

6.
Change/add data by field.  Globally change/add data using the EDIT and REPLACE TEXT option.

7.
INSERT a new record into your user workfile.

8.
DELETE your user workfile.
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Build a Configuration (RT2) Query

1) Go tothe Configuration (2) query screen and REMOVE ALL

2) Add the fallawing fizlds
- Ship Hull (ACT) - From the Activiy (ref) Table
~RIN, RIC, HSC, SERIAL NUMBER LOCATION,ISC - From the Corfig (Primary) Tabie
- EFD,ESD (r2-CFF) From the Giass Functional File Reference Table

3) Move the fallawing fields
-ESD under HSC
- EFD undsr ESD

4)Using HELP, whatis EFD, ESD, and ISC

5) Savethe ad hoc query as your last name,
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Browse Screen

1)Go tothe Configuration (2) query screen and REMOVE ALL
2) Add The following fields
- Ship Hull (ACT)
- RIN, RIC, HSC, SERIAL NUMBER,LOCATION, ISC
- EFD,ESD (ref-CFF)
3) Set the Ship Hull FILTER to DDG 68
4) Typz RIC 00002100 in the RIC FILTER and Click OK
) SORT on LOCATION
6) MOVE ESD between RIC and HSC
7)INCREASE EFD field to read complets EFD.
) DECREASE Serial Number field

9) Go through steps to SAVE as an Excel file with headers
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Detail Screen

1)Go to the Configuration (2) query screen and REMOVE ALL
2) Add The following fields
- Ship Hull (ACT)
- RIN, RIC, HSC, SERIAL NUMBER LOCATION, ISC
- EFD,ESD (ref-CFF)
3) Set the Ship Hull FILTER to DDG 68
4) Typz RIC 00004804 in the RIC FILTER and Click OK
5) Click Detail button
) Double-click on each Hat Key field (RIC, HSC, Parent RIC)
7) Click an 1SC field, then click on Reference Library leon
8) Click an DOVC field, then click on Utilties. From the drop-down menu, click Ref Library.

9) How many parts are assaciated with this recard?
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